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1  General
 1.1  Product Introduction

Fusion4 Portal software suite is used for remote monitoring and configuration of 
hazardous area devices. The Portal suite facilitates remote management by 
operators and supervisors via Ethernet or Serial communication, for centralized 
control and the highest standards of reliability.

Available as a modular package, users can bundle together only the functions they 
require into a common on-screen dashboard.

 l The Print module provides all reconciliation printing functions to radically cut 
the paperwork burden: W&M approved bill of lading printing, transaction 
printing, scheduled printing, and summary printing, as well as configurable free 
form data entry supporting localized languages.

 l The Monitor module gives a real time audit trail of each and every device 
transaction for simplified compliance and reconciliation, as well as alarm and a 
comms monitoring and management panel for rapid identification and 
pinpointing of faults. The Live Viewer function allows the operator to view any 
field devices in real-time on screen at the click of a mouse.

 l The Configuration module permits remote uploading and downloading of 
individual or complete device parameter settings from the Portal dashboard to 
get the operation working quicker.

The application is compliant with the European Directive 2004/22/EC (Measuring 
Instruments Directive).
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Figure 1-1: Fusion4 Portal

 1.2  Target Group for This Manual
This manual is intended for:

 l Administrators who are assigned to install Fusion4 Portal

 l Administrators, engineers, system integrators and supervisors who are 
assigned to configure and maintain Fusion4 Portal

 l Operators who are assigned to operate Fusion4 Portal

 1.3  Prerequisites for Fusion4 Portal 
Installation

 l Fusion4 Portal should be installed on a standalone computer.

 l If Terminal Manager coexists with Fusion4 Portal,
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In TM lookup configuration (LookupTypeCode =WorkflowConfiguration,  Name = 
F4PIntegrated).

If the F4PIntegration is TRUE, then TM does not send the TS (Transaction Settle) 
command to BCU, whereas if the F4PIntegration is FALSE, then TM sends the TS 
command to BCU.
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2  Safety
 2.1  Safety Conventions
2.1.1  Warnings

The following warning formatting used in the manual recommends your attention 
to prevent personal injuries or dangerous situations.

WARNING:  General warning. It is always explained by text.

2.1.2  Cautions
The following caution formatting and symbols used in the manual recommends 
your attention to prevent damages to the equipment.

CAUTION:  General caution information.

 

CAUTION:    Electrostatic discharge (ESD) sensitive device.

 2.2  Liability
Guidant disclaims any responsibility for personal injury or damage to equipment 
caused by:

 l Deviation from any of the prescribed procedures

 l Execution of activities that are not prescribed

 l Neglect of the safety regulations for handling tools and inflammable fluids, and 
use of electricity
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The contents, descriptions, and specifications in this manual are subject to change 
without notice. Guidant accepts no responsibility for any errors that may appear in 
this manual.

WARNING:  Only personnel that are authorized by the customer are allowed to 
make changes on the Fusion4 Portal system. All modifications must be in 
accordance to the guidelines as set forth by Guidant. 
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3  System Description
 3.1  General

Fusion4 Portal allows you to:

 l Automatically create site by scanning and discovering all the Fusion4 devices 
connected to the Fusion4 Portal machine.

 l Configure Fusion4 devices remotely.

 l Scan and print the transaction data of devices (1 up to 50): 1010CB preset 
controllers, Single Stream Controllers for Blending (SSC-B), Single Stream 
Controllers for Additive Injection (SSC-A), Multi Stream Controllers for Additive 
Injection (MSC-A), and Multi Stream Controllers for Loading (MSC-L).

 l Remotely view live loading details of Fusion4 devices.

 l Remotely view the device health status.

 l Provide an interface with an OPC server that scans the 1010CB devices 
continuously to provide real-time values, alarms, and the current state of the 
devices.

 l Scan Fusion4 devices (SSC-A, SSC-B, MSC-A, and MSC-L) for possible alarms.

 3.2  System Architecture
Fusion4 Portal is a software suite running in the safe area or to be more specific, in 
the control room. It consists of the following integrated features:

 l Scan (see Section 3.2.1: Scan )

 l BoL Handling (see Section 3: System Description)

 l Print BoL (see Section 3.2.3: Print BoL)

 l OPC Server (see Section 3.2.4: OPC Server)
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The following figure represents the “Fusion4 Portal functional drawing - Serial 
connection”.

Figure 3-1: Fusion4 Portal functional drawing - Serial connection

The following figure represents the “Fusion4 Portal functional drawing - Ethernet 
connection with terminal server”.
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Figure 3-2: Fusion4 Portal functional drawing - Ethernet connection with terminal server
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3.2.1  Scan 
The Scan feature is started automatically when the computer is started. This feature 
communicates continuously with all connected devices. As soon as a device has 
new transaction data available, the Scan feature retrieves this data. This fully 
automatic process takes place in the background out of user’s sight. Therefore, no 
user interaction is required.

The Scan feature communicates via all computer ports concurrently (if more than 
one port is used). Therefore, Fusion4 Portal is able to respond quickly when new 
data from a device becomes available.

In addition to retrieving transaction data from the connected devices, the Scan 
feature also retrieves realtime data during loading, alarms and operational 
parameters as well.

NOTES:

 1. Cabling for the 1010CB is described in Card Descriptions and Wiring Manual 
Load Computer 1010CB.

 2. Cabling for the SSC-A and the SSC-B is described in the SSC manuals.

 3. Cabling for the MSC-A is described in the MSC-A manual.

 4. Cabling for the MSC-L is described in the MSC-L manual.

3.2.2  BoL Handling 
The BoL Handling feature is responsible for printing the Bill of Lading (BoL). When 
transaction data from a connected device is received and the print transaction 
function of the device is enabled, the data, including the applicable engineering 
units, is immediately printed resulting in a BoL. This print action starts automatically 
without human intervention. The BoL is printed for custody transfer when a 
product from storage tanks has been transferred to other parties. For this reason, 
all Fusion4 Portal features involved in retrieving the transaction details and 
printing/reprinting the Bill of Lading are W&M compliant and approved by a 
notified body.
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3.2.3  Print BoL
Transaction data stored on the hard disk can be viewed and printed with the Print 
BoL feature. This feature enables you to search for a specific transaction or to 
search for one or more transactions that were completed and stored on a specific 
date or within a specific period of time. Subsequently, the details of one or more 
transactions can be viewed and/or printed. In case of an SSC-A and MSC-A, the 
printout is an additive transaction summary. In case of a 1010CB, SSC-B, or an MSC-
L, the printout is a Bill of Lading.

3.2.4  OPC Server
Fusion4 Portal provides an OPC Server feature named Fusion4 that communicates 
with the 1010CB preset controllers and the Fusion4 devices (SSC-As, SSC-Bs, MSC-
As, and MSC-Ls). Fusion4 offers OPC connectivity with OPC clients to read, 
subscribe and write values to the 1010CB device to achieve the required workflow 
at the terminals. An example of an OPC client is a Terminal Automation System 
(TAS). Fusion4 scans the 1010CB preset controllers continuously to provide real 
time values and the current state of the devices.

 3.3  System Requirements
To install Fusion4 Portal, the following hardware components and software are 
required.

3.3.1  Minimum Hardware Requirements
The following table describes the minimum hardware requirements for installing 
Fusion4 Portal.

Table 3-1: Minimum Hardware Requirements

Hardware Description
Processor Intel® Xeon® Quad Core 32/64 bit
Memory 4 GB RAM
Free space 1000 GB hard disk, 7200 RPM
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Hardware Description
Reader CD-ROM / DVD drive with 40 speed
Video card (Graphics 
card)

Resolution 1080 x 800 resolution, 32-bit true color

Keyboard Standard US keyboard
Mouse USB mouse or bus mouse
Serial port One or two (recommended) RS-232 ports + RS-485 ports

USB port
Three USB ports to support USB mouse, keyboard and 
printer

Network interface 
card

10 or 100 Mbps integrated Ethernet Net- work Interface 
card

Printer

The printer should have detection for:

 l Out-of-paper

 l Limited available ink

 l Communication failure between PC and printer

The printer should support A4 or letter. Color print out is 
not required.

3.3.2  Software Requirements
The following table describes the software requirements for installing Fusion4 
Portal.

Table 3-2: Software Requirements

Software Description
Operating 
system

Windows 10 Professional Edition in English (US) language 64-bit 
version

 3.4  Graphical User Interface
In general, all the user interface screens in the Fusion4 Portal application have a 
similar look and feel based on a Windows Explorer type of user interface.
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Figure 3-3: Fusion4 Portal window layout

 1. Application Menu, see section 3.4.1

 2. Section Menu, see section 3.4.2

 3. Site tree panel, see section 3.4.3

 4. Alarm panel, see section 3.4.4

 5. Work panel, see section 3.4.5

3.4.1  Application Menu
The header displays the name of the application and also contains menu options 
namely File, Edit, Reports, Print, and Help.

3.4.1.1  About
When you select About... from the Help menu, the About window is displayed. This 
window provides information about the versions of the Fusion4 Portal s.
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Furthermore, the About window provides information about the available Fusion4 
Portal license options.

The possible license options are described in the table below.

Table 3-3: Description of license options

License 
Option

Description

Number of 
field devices

The value is based on the number of field devices in the site.

 l S: Up to 10 devices.

 l L: Up to 50 devices.

Print license

The Print license is based on the following:

 l U: Transaction & BoL Printing

 l X: EU MID Compliant Transaction & BoL Printing

 l N: No transaction retrieval and no printing
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License 
Option

Description

Configuration 
license

The Configuration license is based on the following:

 l C: Remote configuration of Fusion4 devices.

 l N: No remote configuration of Fusion4 devices.

Monitor 
license

The Monitor license is based on the following:

 l M: Monitors the Fusion4 device alarms, updates the device 
health status in the site tree view, and displays the live loading 
details of the Fusion4 devices.

 l N: Fusion4 device alarms and live loading screen are not 
available.

OPC license

The OPC Interfacing license is based on the following:

 l V: Multi-client OPC server

 l N: No external OPC client

NOTE:  The Auto Discover and Diagnostics features are available as part of the 
basic Fusion4 Portal license.

3.4.2  Section Menu
The various menu buttons are Transactions, Diagnostics, Configuration, and Logs.

3.4.3  Site Tree Panel
The site tree panel shows a tree containing the contents of the site. It shows all the 
elements configured with Fusion4 Portal, and is used to navigate through the 
elements. Examples of elements are: COM ports, IP ports, loading bays and devices.

The communication status of each device is displayed in the site tree, in the Fusion4 
Portal application.
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Table 3-4: Device Communication Statuses

Device Icon Color Description

Device is not enabled for scanning - Initial state

Device communication is healthy
Device communication error

NOTE:  The site tree panel is available in the Fusion4 Portal application and the 
Print BoL application. The site tree panel is not available in the Enraf Process 
Control Centre (EPCC) application and the License Manager application.

3.4.4  Alarm Panel
The Alarm panel displays a list of active alarms in chronological order with the 
newest alarms on top of the list. For more details, see Section 10.3: Monitoring 
Alarms.

3.4.5  Work Panel
The work panel displays the data of the node selected in the site tree panel 
depending on the option selected in the Section menu.

NOTES: 

 1. The Transactions panel displays the site-level, port-level, and/or device-level 
transactions.

 2. The Diagnostics panel displays the details of dashboard and system health 
for the selected device.

 3. The Configuration panel displays the various configuration options for the 
selected device.

 4. The Logs panel does not display the data of the node selected in the site 
panel, but displays the events logged by the Fusion4 Portal applications. By 
default, the most recent logged event is displayed on top of the list, and the 
list is automatically updated.

Fusion4 Portal Installation & Operation Manual

3  System Description | 15



Any or all of the following menu items are available as part of the Fusion4 Portal 
pages.

Buttons/Fields Functionality
Apply Data Allows you to apply the settings.
Get Data Allows you to get the current values from the device.

Last read time
Allows you to view the time when the current values from the 
device were last read.

Undo Cancel the applied settings.
Live Viewer 

Remotely monitor the current loading details of the device.

The work panel also displays the selected options in breadcrumbs as shown in the 
following figure.

For example: MSCL01 > Device Configuration > General > Identification

You can click the required links in the breadcrumbs to go to the corresponding 
group.
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4  Migration from Fusion4 
Portal R221.1 to R222.3

CAUTION:  The migration of Fusion4 Portal must be carried out by a user with 
administrator privileges.

This chapter is intended for users migrating from Fusion4 Portal R220.1 installed 
on Windows 7 32-bit OS to Fusion4 Portal R221.1 on Windows 10 64-bit Operation 
system.

NOTE:  For versions prior to Fusion4 Portal R220.1, first upgrade to R221.1 and 
then migrate to R222.3. Refer to the Fusion4 Portal R221.1 Installation & 
Operation Manual for more information. When you migrate from R221.1 to 
R222.3, the seal is broken.

 4.1  Pre-Installation
Before installing Fusion4 Portal R222.3 on Windows 10 machine, create a backup of 
the ‘...\ProgramData\Enraf’ folder and its contents from the existing Fusion4 Portal 
R220.1 machine.

 4.2  Installation
 1. Obtain a Fusion4 Portal License for the Windows 10 machine

 2. Install Fusion4 Portal R221.1 application

Refer to Section 5.2: Preparing to Install Fusion4 Portal and Section 5.3: Installing 
Fusion4 Portal for more information.
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 4.3  Post-Installation
After installing Fusion4 Portal R222.3, you should perform the below steps to 
migrate Fusion4 Portal R221.1 to Fusion4 Portal R222.3. 

 1. If the Enraf BoL Printer through Enraf Process Control Centre (EPCC) is running, 
stop it. 

 2. Copy contents from the backup taken as per section 4.1 to any desired location 
on destination machine (ex: c:\temp)

 3. Import a Site Database. Perform the following steps to import the configuration 
data 

From the File menu, select Import. The Site Control window is displayed.

Click Import. The Open Site Database File window is displayed.
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Browse to the backup directory containing the site database file (.mdb file).

Select the site database file and then click Open.

The site database is imported.

 4. Import transaction data 

Copy all the contents from the ‘Fusion4Portal’ folder in the backup directory to 
‘...\ProgramData\Enraf\Fusion4Portal’ folder

 5. Restart the computer.

 6. Start the Fusion4 Portal R222.3 application.

 7. Ensure that the site settings are restored appropriately.

 8. Perform a transaction and check if the transactions are displayed in the 
Transactions panel in the Fusion4 Portal and Print BoL applications.

You can also view the transactions of Fusion4 Portal R222.1 by using the 
appropriate search criteria in the Transactions panel in the Fusion4 Portal and 
Print BoL applications.

 9. Ensure that the Fusion4 Portal is sealed.
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5  Installation 
CAUTION:  The installation of Fusion4 Portal must be carried out by a user with 
administrator privileges.

 5.1  Prerequisites
Ensure that the following prerequisites are met before you begin the Fusion4 
Portal installation.

 l Devices are configured with appropriate serial numbers.

 l MSC-A/MSC-L devices have a valid license (not a developer license).

 l Transactions having serial number with “*” or having no serial numbers are 
manually settled or cleared. Refer Section 13.4: Troubleshooting.

 l Devices have appropriate firmware versions. Refer Section 13.4: 
Troubleshooting.

 5.2  Preparing to Install Fusion4 Portal
5.2.1  Obtaining a Fusion4 Portal License

Before installing Fusion4 Portal, you must obtain the Fusion4 Portal license from 
Guidant Support.

To obtain the Fusion4 Portal license from Guidant, perform the following steps:

 1. From the Start menu select Run....

The Run dialog box is displayed.
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NOTE:  If Run... is not displayed in the Start menu: (1) Right-click on the Start 
menu icon and select Properties from the pop-up menu; (2) On the Start 
Menu tab in the Taskbar and Start Menu Properties window click 
Customize...; (3) In the Customize Start Menu window, select the Run 
command check box and click OK to save the changes and to close the 
window; (4) Click OK to save the changes and to close the Taskbar and Start 
Menu Properties window.

 2. Enter cmd in the Run dialog box and then click OK.
The MS-DOS Prompt window is displayed.

 3. Enter ipconfig/all in the command window and press <ENTER>.
The Ethernet adapter Local Area Connection details are listed.

 4. Note down the Physical Address for the Ethernet adapter for which you want to 
request a license.
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NOTE:  This has to be the physical address of the target computer, i.e. the 
computer on which Fusion4 Portal will be installed and running.

 5. Enter exit and press <ENTER>.
The MS-DOS Prompt window is closed.

You will receive an e-mail containing the following information:

 l A hyper link to the location to get your license

 l The name of the person who requested the license

 l The e-mail address of the person who requested the license

 l The Order ID

 l A code

 6. Click the hyper link stated in the e-mail you received.

The Enraf License window is displayed.

 7. Enter the name, e-mail address, order ID, and code stated in the e-mail you 
received. Also enter the physical address (MAC address) of the pc on which 
Fusion4 Portal will be installed and running. 

 8. Click Send.
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You will receive an e-mail with the license (xml file) as an attachment.

 9. Save the xml file on your pc.

 5.3  Installing Fusion4 Portal
Installation of Fusion4 Portal must be carried out in the following order:

 1. Installing Fusion4 Portal, refer to Section 5.3.1: Installing Fusion4 Portal

 2. Setting up a Fusion4 Portal license, refer to Section 5.3.2: Setting Up a Fusion4 
Portal License

 3. Creating user accounts, refer to Section 5.3.3: Creating User Accounts

 4. Assigning users accounts to user groups, refer to Section 5.3.4: Assigning Users 
to a User Group

 5. Configuring the default printer, refer to Section 5.3.5: Configuring the Default 
Printer

 6. Restarting the computer, refer to Section 5.3.6: Restarting the Computer

5.3.1  Installing Fusion4 Portal
To install Fusion4 Portal on your computer, perform the following steps:

 1. Log on to the computer as Administrator.

 2. Insert the CD-ROM into the CD-ROM or DVD drive on your computer.

 3. Click Install_Fusion4_Portal_R222.3.

NOTE:  When User Account Control is enabled on the computer, Windows 
displays the User Account Control window during the installation of 
Microsoft .NET Framework 4.
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 4. Click Yes.

The Fusion4 Portal R222.3 splash screen is displayed.

NOTE:  If installation of Fusion4 Portal does not start automatically, browse 
the contents of the CD-ROM and double-click Install_Fusion4_Portal_R222.3
.exe.

 5. Click Install at the top left side of the window.
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After some time, the following message is displayed.

 6. Read the message and then click OK.

The Welcome to the InstallShield Wizard for the Fusion4 Portal R221.1 window is 
displayed.

 7. Click Next.

The License Agreement window is displayed.
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 8. Read the license agreement. To print the license agreement, click Print. If 
agreed upon, select I accept the terms in the license agreement, and then click 
Next.

The Destination Folder window is displayed.

 9. If necessary, change the directory, and then click Next.
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The Setup Type window is displayed.

 10. Select the setup type and then click Next.

 l Select Standard to install all features of Fusion4 Portal.

If you selected Standard, the Ready to Install the Program window is 
displayed. Proceed with step 11.

 l Select Custom to select the features of Fusion4 Portal you want to install.

If you have selected Custom, the Custom Setup window is displayed.
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NOTE:  If the optional “OPC Server” function is ordered, then beware that 
external applications can influence the behavior of Fusion4 Portal 
through OPC and that certain commands can be issued through OPC.

 11. Select the Fusion4 Portal features you wish to install and then click Next.

The Ready to Install the Program window is displayed.
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 12. Click Install.

NOTE:  If Microsoft .NET Framework 4 is not installed on the computer, the 
following message is displayed during installation.

 13. Click Yes to install Microsoft .NET Framework 4. 

After Microsoft .NET Framework 4 is installed, the machine is automatically 
restarted.

 14. After the computer is restarted, follow steps 1 to 12 to install Fusion4 Portal.

The installation of Fusion4 Portal starts.

At the end of the installation of Fusion4 Portal, the mngr Account window is 
displayed.
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 15. In the Password field, enter the password for the mngr account. In the Retype 
password field, enter the same password again, and then click OK.

NOTE:  The mngr account is needed to keep Fusion4 Portal running when no 
user is logged on.

 16. If the mngr account already exists on your computer, the mngr Account window 
only contains the Username and Password fields. Enter the existing password 
and then click OK.

NOTE:  If the password you entered is incorrect, the following message is 
displayed.

Click OK to close the message. Enter the correct password.

CAUTION:  If you cannot remember the password for the mngr account, click 
Cancel in the mngr Account window. Though the installation of Fusion4 
Portal continues, you must fix the incorrect password issue in order for 
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Fusion4 Portal to work. See Section 13.4.1: Correcting Log On for Enraf BoL 
Printer Service for more information.

The following message is displayed:

 17. Click OK.

The InstallShield Wizard Completed window is displayed.

 18. Click Finish.

Fusion4 Portal is installed on your computer.

The Fusion4 Portal applications are displayed under Start | All Programs | 
Enraf.
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5.3.2  Setting Up a Fusion4 Portal License
After you installed Fusion4 Portal on the computer, you have to set up the license. 
For obtaining a Fusion4 Portal license, refer to Section 5.2.1: Obtaining a Fusion4 
Portal License.

To set up a Fusion4 Portal license, perform the following steps:

 1. From the Start menu, select All Programs | Honeywell Enraf | License Manager 
| License Manager.

The License Manager window is displayed.
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 2. From the File menu, select Add a license or click Browse.

The Select a license file window is displayed.

 3. Browse to the directory containing the license file.

 4. Select the license file and then click Open.

If a license for Fusion4 Portal already exists, the following message is displayed.
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 5. Click Yes to replace the old license with the new license.

The (new) license is displayed in the License Manager window.

 6. Click Exit to save the configuration of the license and to close the License 
Manager window.

5.3.3  Creating User Accounts
To enable users to log on to, start, stop and use Fusion4 Portal, you have to create 
user accounts for these users.
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CAUTION:  Engineer privilege must be given only to the required individuals who 
are involved with configuration manipulations and who understand the 
complete system.

Users with Engineer privilege must not share the confidential data.

 1. Log on to the computer with the “mngr” account.

 2. From the Start menu, select Control Panel.

The Control Panel is displayed.

 3. Click System and Security.

The System and Security control panel is displayed.
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 4. Click Administrative Tools.

The Administrative Tools control panel is displayed.  

 5. Double-click Computer Management.
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The Computer Management window is displayed.

 6. Under System Tools, select Local Users and Groups | Users.

The list of user accounts is displayed.

 7. From the Action menu, select New User.

The New User window is displayed.
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NOTE:  You can also right-click Users, and then select New User.

 8. Enter the properties of the user account. The properties are described in the 
following table.

Table 5-1: Description of User Account Properties

Field             Description
User name Enter the name of the user account.
Password Enter the password for this user account.
Confirm password Re-enter the password for this user account.

 9. Click Create to create the user account. 

 10. Click Close to close the New User window.

The Computer Management window is displayed again. The user account is 
listed in the list with user accounts.
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5.3.4  Assigning Users to a User Group
In order for users to have the necessary access rights in Fusion4 Portal, you have to 
assign each user account you created to the appropriate user group. In Fusion4 
Portal, a user account needs to be assigned to one of the following user groups:

 l F4PAdministrators
 l Engineers
 l Operators
 l Supervisors

To assign a user account to one or more of the user groups listed above, perform 
the following steps:

 1. Log on to the computer with the “mngr” account.

 2. From the Start menu, select Control Panel.

The Control Panel is displayed.
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 3. Click System and Security.

The System and Security control panel is displayed.

 4. Click Administrative Tools.

The Administrative Tools control panel is displayed.
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 5. Double-click Computer Management.

The Computer Management window is displayed.

 6. Under System Tools, select Local Users and Groups | Users.

The available user accounts are listed. 
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 7. In the list with available user accounts, select the user account you want to 
assign to one of the user groups listed above.

 8. From the Action menu, select Properties.

The Properties window for the selected user is displayed.

NOTE:  You can also right-click the name of the user in the list of users, and 
then select Properties.

 9. Click the Member Of tab.

 10. Click Add.

The Select Groups window is displayed.
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 11. Enter the name of the user group you want to assign the selected user to in the 
Enter the object names to select text box, and then click Check Names.

If the name of the user group you entered is located, the name including its 
location is displayed in the text box.

 12. Click OK to save the changes and then close the window.

The Properties window for the selected user is displayed. The user group to 
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which you assigned the user is listed under Member of.

 13. Click OK to save the changes and to close the window.

5.3.5  Configuring the Default Printer
The printer that is used to print the Bills of Lading, Transaction summaries, and 
Schedule reports must be configured as the default printer.

NOTE:  Before configuring a printer as default printer, install the printer drivers.

To configure the printer, perform the following steps:

 1. Log on to the computer with the “mngr” account.

 2. From the Start menu, select Control Panel.

The Windows Control Panel is displayed.

 3. Click Hardware and Sound.
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The Hardware and Sound control panel is displayed.

 4. Click Devices and Printers.

The Devices and Printers window is displayed.

 5. Under Printers and Faxes, right-click the printer you want to use as default 
printer, and then select Set as default printer.

A check mark is displayed indicating that the printer is setup as default printer. 
Also when you right-click the printer, the Set as default printer option is 
checked.

5.3.6  Restarting the Computer
After you configure the default printer, you must shutdown and restart the 
computer.

 5.4  Removing (‘Uninstalling’) Fusion4 Portal
To remove (uninstall) Fusion4 Portal from your computer, perform the following 
steps:

 1. Close Fusion4 Portal.

 2. Stop all services and exit the Enraf Process Control Centre (EPCC).

 a. Right-click the EPCC icon in the system tray.
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 b. In the EPCC user interface, choose Enraf Processes | All Tasks | Stop All to 
stop all services. 

 c. Ensure that all the EPCC user interface displays all services, and that 
Fusion4Server and Print manager are stopped.

 d. In the EPCC user interface, select Exit to exit the EPCC.

 3. Insert the Fusion4 Portal CD-ROM into the CD-ROM or DVD drive on your 
computer.

The Fusion4 Portal R222.3 splash screen is displayed. 

 4. Click Install at the top left side of the window.

The following message is displayed:
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 5. Click OK.

The Welcome to the InstallShield Wizard for the Fusion4 Portal R222.3 window is 
displayed.

 6. Click Next.

The Program Maintenance window is displayed.
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 7. Select Remove and then click Next.

The Remove the Program window is displayed.

 8. Click Remove to remove Fusion4 Portal.

When Fusion4 Portal is removed from the computer, the InstallShield Wizard 
Completed window is displayed.
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 9. Click Finish.

NOTE:  After removal of Fusion4 Portal, the following programs remain on the 
computer: SAP Crystal Report runtime engine for .NET Framework 4 (32-bit) and 
OPC Core Components 2.00 Redistributable. Furthermore, the site database 
and the contents of the BoL store, if present, are not deleted.
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6  Site Settings
CAUTION: 

 l The configuration of Fusion4 Portal should be carried out by a user with 
Supervisor or Engineer privileges or by F4PAdministrators

 l Operators who are logged in are allowed to start Fusion4 Portal and have 
read-only access, i.e. they can read the various parameters but do not have 
the rights to change them

Fusion4 Portal              enables you to:

 l Create and maintain a visual representation of a site and site database to 
support 1010CB load controllers (1010CBs), Single Stream Controllers for 
Additive Injection (SSC-As), Single Stream Controllers for Blending (SSC-Bs), 
Multi-stream Controllers for Additive Injection (MSC-As), and Multi-stream 
Controllers for Loading (MSC-Ls). (Refer to Section 6.1: Creating and Maintaining 
a Site Database)

 l Configure and maintain the properties of a site (Refer to Section 6.2: 
Configuring Site Settings)

To start the Fusion4 Portal, perform the following step:

 1. From the Start menu select All Programs | Enraf | Fusion4 Portal.

The main window of Fusion4 Portal is displayed.             
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Figure 6-1: Fusion4 Portal main window

NOTE:

 l The first time you start Fusion4 Portal, the window is empty as no site has 
been created yet.

 l Ensure that the EPCC window is not displayed in the center of the monitor.

 6.1  Creating and Maintaining a Site Database
6.1.1  Creating a Site Database

To create a site, perform the following steps:

 1. Start Fusion4 Portal.

 2. From the File menu, select New... or press [Ctrl+N].

The Site Control window is displayed.
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 3. Click New.

The Site Name window is displayed.

 4. Enter the site name (maximum 32 characters) and then click OK.

The new site is displayed in the site tree.

NOTE:  The site name is displayed on the Bill of Lading.

6.1.2  Renaming a Site Database
To rename a site, perform the following steps:

 1. If the site you want to rename is opened, close it. From the File menu, select 
Close.

 2. From the File menu, select Open or press [Ctrl+O].
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The Site Control window is displayed.

 3. In the Site list, select the site you want to rename.

The name of the site is highlighted.

 4. Click Rename.

The Site Name window is displayed.

 5. Enter the new name of the site and then click OK.

The site is renamed.

6.1.3  Deleting a Site Database
To delete a site, perform the following steps:

 1. If the site you want to delete is opened, close it. From the File menu, select 
Close.

 2. From the File menu, select Open or press [Ctrl+O].

The Site Control window is displayed.
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 3. In the Site list, select the site you want to delete.

The name of the site is highlighted.

 4. Click Delete.

The following message is displayed:

 5. Click Yes to delete the site.

The following message is displayed:

 6. Click Yes to delete the database directory and related files.
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The site is removed.

NOTE:  If you click No, the site is removed from the site list in the Site Control 
window only, but remains stored in the Fusion4 Portal machine.

6.1.4  Importing a Site Database
You can import a site database that was already created.

To import an already created site database, perform the following steps:

 1. From the File menu, select Import.

The Site Control window is displayed.

 2. Click Import.

The Open Site Database File window is displayed.
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 3. Browse to the directory containing the site database file (.mdb file).

 4. Select the site database file and then click Open.

The site database is imported.

 6.2  Configuring Site Settings
You can configure the site settings such as general, reports, configuration units, 
and MSC-L BOL customization.

CAUTION:  The settings that you configure using these tabs are applicable to the 
selected site.

 1. In Fusion4 Portal, select File > Settings.

The Settings dialog box is displayed. 
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 2. In the General tab, configure the following settings.
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Table 6-1: Description of General Settings

Field Description

TAS Status

Enables you to determine if and how a connected 
Terminal Automation System (TAS) influences the 
behavior of Fusion4 Portal.

 l Disabled - The presence or absence of the 
connected TAS does not influence the behavior 
of Fusion4 Portal.

 l Binary - The connected TAS announces its 
presence/absence by a writeable OPC item from 
Fusion4 Portal, which is either True or False.

 l Time Ticker - The connected TAS indicates its 
presence by continuously changing the value of 
a writeable OPC item from Fusion4 Portal. If the 
changing of the value of the OPC item stops, 
then Fusion4 Portal behaves as if the TAS is 
absent. The value for this field must be an 
integer.

NOTE:  The TAS status has only influence on 
1010CB devices.
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Field Description

UI and BOL language

Enables you to configure the language in which the 
Fusion4 Portal application and reports (BoL, 
transaction summary, and summary reports) must 
be displayed.

By default, the Fusion4 Portal application supports 
the following 13 languages.

 l English - US
 l English - UK
 l French
 l German 
 l Dutch
 l Spanish
 l Chinese
 l Japanese
 l Polish
 l Portuguese
 l Italian
 l Swedish
 l Hindi

Fusion4 Portal Installation & Operation Manual

6  Site Settings | 59



Field Description

Device Time 
Synchronization

This feature maintains the date and time 
coordination between the Fusion4 Portal computer 
clock and all the Fusion4 clocks across Fusion4 
Devices (MSCL, MSCA, SSCB, SSCA). When there is a 
mismatch in the time due to the clock drift, the 
Device Time Synchronization setting enables to sync 
the time between Fusion4 Portal computer clock 
and each clock of the Fusion4 devices. The Default 
Disabled option is set for disabling time sync.

NOTE:  The process repeats in every 24 hrs at the 
configured time. If there is any configuration 
change needed, then restart the Fusion4 Time 
Sync service. For R221.1 sites close the existing 
sites and reopen it using below menu item.

File -> Open and click on Select Database.

For example, if you select the language as “Chinese” and restart the Fusion4 
Portal machine, the Fusion4 Portal application is localized to “Chinese” as shown 
in the following figure. 

 3. Click the Reports tab.
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The dialog box is displayed as follows.

 4. In the Reports tab, configure the following settings.

Table 6-2: Print Settings

Field Description
Print to 
printer

To print a hard copy of the reports (BoL, transaction summary, and 
summary reports) using the default printer for the “mngr” account. 

Print to 
file

To save the reports (BoL, transaction summary, and summary reports) 
as a PDF file. 

By default, the path to the “Print to file” storage folder is 
‘C:\Users\Public\Documents\Honeywell Enraf\[Site Name]’.

You can also change the path where the PDF files must be saved using 
the Browse. button. See also Section 6.2.1: Printing reports to file.

Disable 
print

Automatic printing of reports (BoL, transaction summary, and 
summary reports) is disabled.
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Table 6-3: Description of Report Settings

Field Description
Printing options

BoL
When a new transaction is retrieved from the 1010CB, SSC-B, and 
MSC-L devices, the BoL can be generated based on the settings 
configured in the the table above.

Transaction 
Summary

For every 25 additive transactions retrieved from the SSC-A or 
MSC-A devices, the additive transaction reports can be generated 
based on the settings configured in the table above.

Summary 
report

Based on the schedule reports configuration, the additive and 
blend summary reports can be generated based on the settings 
configured in the above table.

NOTE:  The Disable Print option is not applicable. 

Print to File

The Bills of Lading, transaction summaries, and/or summary 
reports are saved in the path configured in this field. 

For more information, see Section 6.2.1: Printing reports to file.

Decimal 
symbol

The value configured in this field is used to indicate the decimal 
point symbol in the BoL, transaction summary reports, and 
summary reports.

Digit 
grouping 
symbol

The value configured in this field is used to indicate the digit 
grouping symbol in the BoL, transaction summary reports, and 
summary reports.

Digit 
grouping

The value configured in this field is used to indicate the digit 
grouping in the BoL, transaction summary reports, and summary 
reports

Schedule report
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Field Description

Report type

 l Additive Stream - If you want to generate summary reports for 
additive streams, select the check box. Otherwise, leave the 
check box empty.

 l Blend Stream - If you want to generate summary reports for 
blend streams, select the check box. Otherwise, leave the 
check box empty.

By default, these check boxes are not selected.

Report 
Schedule 
Types

 l Daily - If you want to generate the summary reports on a daily 
basis, select the check box. Otherwise, leave the check box 
empty.

 l Weekly - If you want to generate the summary reports on a 
weekly basis, select the check box. Subsequently, select the 
day of the week (Sunday to Saturday) on which the summary 
reports have to be printed. 

If you do not want to generate the summary reports on a 
weekly basis, leave the check box empty.

 l Monthly - If you want to generate the summary reports on a 
monthly basis, select the check box. Subsequently, select the 
date of the month (1 to 31) on which the summary reports 
have to be printed. 

If you do not want to generate the summary reports on a 
monthly basis, leave the check box empty.

NOTE:  If the date configured is not applicable for a month, the 
monthly reports are generated on the last day of the month.

For example: If the date configured is “31” and if the month 
does not have 31 days, then the reports are generated on 
30th day.
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Field Description

Report 
generation 
time

Enter the time at which the summary reports have to be 
generated. The default time is ‘03:00:00’ (03:00 AM).

NOTE:  To ensure that the report generation runs smoothly, 
enter a time at which no transactions or hardly any 
transactions take place. 

Volume 
dimension

The volume units displayed in summary reports is based on the 
value specified in this field. 

The available values are L, m3, US gal, and bbl.

NOTES:

 l When a language is selected, the decimal and digit separators are set 
accordingly. You can overrule these settings, i.e. use a comma instead of 
a dot for a decimal separator and/or use a dot instead of a comma for a 
digit separator.

 l Ensure that the values in Windows region and language settings 
(Decimal symbol, Digit grouping symbol, and Digit grouping) match the 
values configured in the Fusion4 Portal application.

 5. Click the Configuration Units tab.

The dialog box is displayed as follows.
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 6. In the Configuration Units tab, configure the following settings.

NOTES:

 l Fusion4 Portal always uses the engineering units of the real device when 
printing and storing the transaction data. 

 l The device configurations are displayed with these units in the Fusion4 
Portal application. 

Table 6-4: Description of Configuration Units Settings

Field Description
Temperature 
dimension

°C or °F

Density dimension kg/m3, °API, lbs/ft3, RD60, kg/l
Pressure 
dimension

kgf/cm2, Pa, kPa, psi, psi_r100, psi_r1000

Volume flow 
dimension

m3/min, L/min, bbl/min, US gal/min, UK gal/min, cm3/min, 
dm3/min
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Field Description
Volume dimension L, m3, bbl, Ugal, cm3, dm3
Mass dimension kg, ton, US ton, US ton, bs or long ton
Mass flow 
dimension

kg/min, metric ton/min, Lb/min, UK Long tn/min

Additive volume 
dimension

ml or cc

Volume K-Factor 
dimension

Pulses/L, Pulses/m3, Pulses/gal, Pulses/bbl, Pulses/Ugal, 
Pulses/cm3, Pulses/dm3

Mass K-Factor 
dimension

Pulses/kg, Pulses/ton, Pulses/US ton, Pulses/lb, 
Pulses/long ton

Temperature 
coefficient

10E-7/°C, 10E-7/°F

 7. Click the MSC-L BOL Customization tab.

The dialog box is displayed as follows.
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 8. In the MSC-L BOL Customization tab, you can customize the MSC-L BOL for a 
particular site. Configure the following settings.

Table 6-5: Description of the MSC-L BOL Customization Settings

Field Description

Show additive 
information

You can display the additive information in the MSC-L BOL 
reports. The additive information is displayed in the 
Compartment totals section. 

Show 
transaction 
generic 
information

You can display the generic information of a transaction in the 
MSC-L BOL reports. The transaction generic information is 
displayed in the BoL header section.

Show batch 
generic 
information

You can display the generic information of a batch in the MSC-L 
BOL reports. The batch generic information is displayed in the 
Batch specifications section.

Transaction 
header fields

Vehicle, Base temperature, Driver, Base pressure, and Bay 
loading

Based on the check boxes selected, the details are displayed in 
the BoL header section.

 9. Select the appropriate check boxes to display the corresponding details in the 
MSC-L BoL reports.

 10. After updating the required settings, click Apply.

The site settings are configured.

6.2.1  Printing reports to file
If the Bills of Lading, transaction summaries, and/or summary reports have to be 
printed to file, you have to enter the path to the storage folder. See Table 6-3: 
Description of Report Settings.

By default, the path to the Print to file storage folder is 
‘C:\Users\Public\Documents\Honeywell Enraf\[SiteName]’. The folder is created 
during the creation of a site in Fusion4 Portal. You can change the location of the 
storage folder to another drive in the same machine or to a remote machine which 
is on the same network.
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NOTE:  If you choose to change the location of the storage folder on a remote 
machine on the same network, the ‘mngr’ user account must have full access 
control to this folder.

 1. Click Browse....

The Browse For Folder window is displayed.

 2. Browse to the folder where the Bills of Lading, transaction summaries, and/or 
summary reports have to be stored. Then click OK.

The Browse For Folder window is closed. The name of the storage folder 
including the path is displayed.
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7  Auto Discover
CAUTION:  Auto-discover can be carried out by a user who belongs to the 
Supervisor, Engineer, or F4PAdministrators group.

You can automatically build the site tree by scanning the Fusion4 devices, which are 
connected via Serial or Ethernet ports, to the Fusion4 Portal machine.

NOTE:  You can automatically discover the Fusion4 devices only, and not the 
1010CB device.

If you automatically discover the same site again, the new devices added along with 
the existing devices are discovered.

WARNING:  If a new device with the FlexConn address same as that of an 
existing device is discovered in the same port and if the old device is not found, 
then the old device is deleted from the site tree.

Fusion4 Portal enables you to:

 l Automatically discover sites (Refer to section Section 7.1: Discovering sites).

 l Automatically discover devices connected to ports (see section Section 7.2: 
Discovering devices connected to ports).

 l Automatically discover devices (see section Section 7.3: Discovering device 
boards).

 7.1  Discovering sites
 1. Start Fusion4 Portal.

The following window is displayed.
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 2. Right-click the site name and then click Auto Discover.

The Auto Discover window is displayed. 

 3. To discover the devices that are connected through Ethernet, perform the 
following based on the Ethernet configurations in the device:
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 a. Select the IP port check box.

 b. In the From and To boxes, type the IP range.

 c. Click Add.

The selected range is displayed under Address range list.

 d. In the Port number box, the default port number is displayed. If the value is 
changed in the FlexConn TCP Port in the device, ensure that you enter the 
same in this field.

 4. To discover the devices that are connected through serial communication, 
configure the following based on the serial COM configurations in the device:

 a. In the Parity drop-down list, type the parity of the selected communication 
port. Select Even, Odd, or None.

 b. In the Databits drop-down list, type the number of data bits of the selected 
communication port. Select either 7 or 8.

 c. In the Stopbits drop-down list, type the number of stop bits of the selected 
communication port. Select either 1 or 2.

 d. In the Baudrate section, select the check boxes corresponding to the baud 
rates of the selected communication port.

The available values are 1200, 2400, 4800, 9600, 19200, 38400, 57600, 
115200, and 128000. The default baud rate is selected as 9600.

 5. Under Common parameters, configure the following:

 a. In the Turn around delay box, type the value for delay of serial 
communication. This delay is the time between reply and request of the next 
message, and is used for the field connection. Enter 0 if the IP port is used to 
connect an SSC-A, SSC-B, MSC-L, or MSC-A.

 b. In the Timeout box, type the time out value of serial communication. This 
time out is the time between request and reply and is used for the field 
connection. Enter 500 if the IP port is used to connect an SSC-A, SSC-B, MSC-
L, or MSC-A
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 c. In the FlexConn device address range boxes, type the range of the 
communication address of the devices. The range is based on the number of 
devices connected to the port address.

 d. In the Retries box, type the number of retries in case of communication 
failure. Enter 0 if the IP port is used to connect an SSC-A, SSC-B, MSC-L, or 
MSC-A.

 6. Click Discover.

All the Fusion4 devices are discovered and displayed under DISCOVERED 
DEVICES on the left pane, as displayed in the following figure. 

 7. Click OK.

 8. Click Save to save the discovered site.

The following message is displayed.
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 9. Click Yes. The site configuration is updated and the following message is 
displayed.

 10. Restart the Fusion4 Portal application.

The site tree is updated with the Fusion 4 devices as displayed in the following 
window.

NOTE:  Ensure that you restart the F4P machine to fetch the transactions 
and alarms.
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 7.2  Discovering devices connected to ports
You can automatically discover the devices connected to the COM ports or IP ports.

7.2.1  Discovering devices connected to IP ports
 1. Start Fusion4 Portal.

 2. In the site tree, right-click the IP port name, and then click Auto Discover.

The Auto Discover window is displayed with values of the selected IP port.

 3. In the FlexConn device address range boxes, type the range of the device 
addresses. The range is based on the number of devices connected to the port 
address.

 4. Click Discover.

All the Fusion4 devices are discovered and are displayed under DISCOVERED 
DEVICES on the left pane. A message is displayed indicating that the auto 
discover is complete.

 5. Click OK.

 6. Click Save to save the discovered devices connected through the IP ports.

The following message is displayed.
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 7. Click Yes. The site configuration is updated and the following message is 
displayed.

 8. Restart the Fusion4 Portal application.

The site tree is updated with the Fusion 4 devices connected to the IP ports.

7.2.2  Discovering devices connected to COM ports
You can automatically discover the devices connected to COM ports.

 1. Start Fusion4 Portal.

 2. In the site tree, right-click the COM port name, and then click Auto Discover.

The Auto Discover window is displayed with values of the selected COM ports.
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 3. In the FlexConn device address range boxes, type the range of the device 
addresses. The range is based on the number of devices connected to the port 
address.

 4. Click Discover.

All the Fusion4 devices are discovered and are displayed under DISCOVERED 
DEVICES on the left pane. A message is displayed indicating that the auto 
discover is complete.

 5. Click OK.

 6. Click Save to save the discovered devices connected through the COM ports.

The following message is displayed.

 7. Click Yes. The COM port configuration is updated and the following message is 
displayed.
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 8. Restart the Fusion4 Portal application.

The site tree is updated with the Fusion4 devices connected to the COM ports.

 7.3  Discovering device boards
You can automatically discover devices when any new boards are added to the 
device or any changes are made in the device license.

7.3.1  Discovering device boards connected to IP ports
 1. Start Fusion4 Portal.

 2. In the site tree, right-click the device name, and then click Auto Discover.

The Auto Discover window is displayed.

 3. Click Discover.
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All the Fusion4 devices are discovered and are displayed under DISCOVERED 
DEVICES on the left pane. A message is displayed indicating that the auto 
discover is complete.

 4. Click OK.

 5. Click Save to save the devices connected through the IP ports.

The following message is displayed.

 6. Click Yes. The site configuration is updated and the following message is 
displayed.

 7. Restart the Fusion4 Portal application.

The site tree is updated with the Fusion4 devices connected to the IP ports.

7.3.2  Discovering device boards connected to COM ports
 1. Start Fusion4 Portal.

 2. In the site tree, right-click the device name, and then click Auto Discover.

The Auto Discover window is displayed.
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 3. Click Discover.

All the Fusion4 devices are discovered and are displayed under DISCOVERED 
DEVICES on the left pane. A message is displayed indicating that the auto 
discover is complete.

 4. Click OK.

 5. Click Save to save the devices connected through the COM ports.

The following message is displayed.

 6. Click Yes. The COM port configuration is updated and the following message is 
displayed.
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 7. Restart the Fusion4 Portal.

The site tree is updated with the Fusion4 devices connected to the COM ports.
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8  Portal Settings
CAUTION:

 l The configuration of Fusion4 Portal should be carried out by a user with 
Supervisor or Engineer privileges or by F4PAdministrators.

 l Operators who are logged in are allowed to start Fusion4 Portal and have 
read-only access, i.e. they can read the various parameters but do not have 
the rights to change them.

Fusion4 Portal enables you to:

 l Create, configure and maintain COM ports to connect Fusion4 Portals, SSC-As, 
SSC-Bs, MSC-As, and MSC-Ls (Refer to Section 8.1: Creating, Configuring and 
Maintaining COM Ports).

 l Create, configure and maintain IP ports to connect MSC-As and MSC-Ls (Refer to 
Section 8.2: Creating and Maintaining an Ethernet Port).

 l Create and maintain loading bays to group 1010CBs, SSC-As, SSC-Bs, MSC-As, 
and MSC-Ls (Refer to Section 8.3: Creating and Maintaining a Loading Bay).

 l Create, configure and maintain 1010CBs (Refer to Section 8.4: Creating, 
Configuring and Maintaining a 1010CB).

 l Create, configure and maintain SSC-As (Refer to Section 8.5: Creating, 
Configuring and Maintaining SSC-A).

 l Create, configure and maintain SSC-Bs (see Section 8.6: Creating, Configuring 
and Maintaining SSC-B).

 l Create, configure and maintain MSC-As (see Section 8.7: Creating, Configuring 
and Maintaining MSC-A).

 l Create, configure and maintain MSC-Ls (see Section 8.8: Creating, Configuring 
and Maintaining MSC-L)
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 8.1  Creating, Configuring and Maintaining 
COM Ports

After a site is created, you can create one or more COM ports (serial ports) in this 
site.

NOTES:

 1. You can connect the following devices to a COM port via a loading bay:

 l 1010CBs
 l SSC-As
 l SSC-Bs
 l MSC-As
 l MSC-Ls

 2. The communication protocol used by the 1010CB for communications 
through serial port differs from the communication protocol used by the 
SSC-A, SSC-B, MSC-A, and MSC-L. Therefore, 1010CBs should not be linked 
to the same COM port as SSC-As, SSC-Bs, MSC-As, and MSC-Ls.

8.1.1  Creating a COM Port
To create a COM port, perform the following steps:

 1. In the site tree, select the site for which you want to create a COM port.
 2. From the Edit menu, select Create Com Port.

NOTE:  You can also right-click the name of the site in the site tree, and then 
select Create Com Port.

The Element name window is displayed.
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 3. Select the number of the COM port (COM1 - COM255) i.e. the communication 
port that is used to connect one or more devices, and then click OK.

The COM port is created.

 4. Enter the properties of the COM port. The properties are described in the 
following table.

CAUTION:  The properties you enter, have to match the settings of the 
connected devices.
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Table 8-1: Description of COM port properties (Including preferred settings)

Com 
Port 

Property
Description

Baud 
Rate

This property indicates the baud rate of the selected communication 
port. 

The available options are 300, 600, 1200, 2400, 4800, 9600, 19200, 
38400, 57600, and 115200.

 l Select the appropriate baud if COM port is used for connecting 
Fusion4 devices (SSC-As, SSC-Bs, MSC-As, and MSC-Ls).

 l Select 9600 baud or higher if COM port is used for connecting 
1010CB devices.

Fixed 
Protocol 
Settings

This property can be used to select fixed communication settings like 
fixed parity or fixed data bits. If fixed protocol settings are true, you 
cannot overrule the parity, data bits, and stop bits properties.

Select False if you want to configure the parity, data bits, and stop 
bits properties.

Parity

This property indicates the parity of the selected communication 
port. 

The available options are None, Odd, and Even.

Data Bits

This property indicates the number of data bits of the selected 
communication port.

The available options are 7 and 8.

Stop Bits

This property indicates the number of stop bits of the selected 
communication port.

The available options are 1 and 2.
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Com 
Port 

Property
Description

Time Out

This property indicates the time out of serial communication. This 
time out is the time between request and reply and is used for the 
field connection.

 l Enter 300 if the COM port is used to connect a 1010CB.

 l Enter 500 if the COM port is used to connect an SSC-A, SSC-B, 
MSC-A, or MSC-L.

Turn 
Around 
Delay

This property indicates the delay of serial communication. This delay 
is the time between reply and request of the next message, and is 
used for the field connection.

 l Enter 300 / x ms, where x = the number of devices on the serial 
line, if the IP port is used to connect a 1010CB.

 l Enter 0 if the IP port is used to connect an SSC-A, SSC-B, MSC-A, 
or MSC-L.

Retries

This property indicates the number of retries in case of 
communication failure.

 l Enter 3 if the COM port is used to connect a 1010CB.

 l Enter 0 if the COM port is used to connect an SSC-A, SSC-B, MSC-
A, or MSC-L.

Scan 
interval

This property indicates the interval at which each device is scanned 
for status change (New alarm or new transactions).

 l Enter 500 in non-multidrop setup

 l Enter 2000 in multidrop setup

NOTE:  This value makes sure that the alarms are reported from 
each device within 5 seconds. Decrease the value if faster update 
is required. Please note: Each device in the multidrop line needs 
to be allocated 400 to 500 ms per scan cycle, for proper 
scanning. Unless the number of devices in a multidrop line is less 
than 5, it does not help if the scan interval is reduced.
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NOTE:  The settings that you configure in the Fusion4 Portal must match the 
device setting to establish communication with the device.

 5. Click Apply to save the settings.

8.1.2  Changing the Value of COM Port Properties
To change the value of one or more properties of a COM port, perform the 
following steps:

 1. In the site tree, select the COM port for which you want to change the value of 
one or more properties.

The properties of the selected COM port are displayed.

 2. Change the value of the property or properties.

 3. Click Apply to save the changes.

8.1.3  Changing a COM Port
To change a COM port, perform the following steps:

 1. In the site tree, select the COM port you want to change.

The name of the selected COM port is highlighted.

 2. From the Edit menu, select Rename.

The Element name window is displayed.

NOTE:  You can also right-click the name of the COM port in the site tree, and 
then select Rename. 

 3. Select a different COM port.

 4. Click OK.
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8.1.4  Deleting a COM Port

NOTE:  If a COM port has one or more loading bays linked to it, you first have to 
delete these loading bays before you can delete the COM port.

To delete a COM port from a site, perform the following steps:

 1. In the site tree, select the COM port you want to delete.

The name of the COM port is highlighted.

 2. From the Edit menu, select Delete.

The following message is displayed:

 3. Click OK if you want to delete the COM port. Otherwise, click Cancel.

The COM port is deleted from the site.

NOTE:  You can also right-click the name of the COM port in the site tree, and 
then select Delete.

 8.2  Creating and Maintaining an Ethernet 
Port

When you created a site, you can create one or more Ethernet ports (IP ports) in 
this site.
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NOTE: The following devices can be connected to an IP port (via a loading bay):

 l MSC-As
 l MSC-Ls

8.2.1  Creating an IP Port
To create an IP port, perform the following steps:

 1. In the site tree, select the site for which you want to create an IP port.

 2. From the Edit menu, select Create IP Port.

NOTE:  You can also right-click the name of the site in the site tree, and then 
select Create IP Port.

The Element name window is displayed.

 3. Enter the name of the IP port that is used to connect one or more devices, and 
then click OK.

The IP port is created.
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 4. Enter the values for each property of the IP port. The properties are described 
in the following table.

CAUTION:  The values you enter, have to match the settings of the connected 
devices.

Table 8-2: Description of IP port properties (Including preferred settings)

IP Port 
Property

Description

IP 
address

This property indicates the IP address of the connected device.

Port 
number

This property indicates the port configured in the connected device 
for communicating with Fusion4 Portal.

Time out

This property indicates the time out of ethernet communication. This 
time out is the time between request and reply and is used for the 
field connection.

 l Enter 500
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IP Port 
Property

Description

Turn 
Around 
Delay

This property indicates the delay that Fusion4 Portal waits between 
two consecutive requests to the device.

 l Enter 0

NOTE:  Keep the turn around delay as small as possible, unless 
there is a specific limitation documented in the device manual 
about its ability to respond to messages fast.

Retries

This property indicates the number of retries in case of 
communication failure.

 l Enter 0

NOTE:  If the line is noisy, increase the number of retries. Please 
note: Increasing the number of retries indicates that Fusion4 
Portal spends longer time on a single device, while ignoring the 
other devices in the same line. 

Scan 
interval

This property indicates the interval at which each device is scanned 
for statu1s change (New alarm or new transactions).

 l Enter 500 in non-multidrop setup

 l Enter 2000 in multidrop setup

NOTE:  This value makes sure that the alarms are reported from 
each device within 5 seconds. Decrease the value if faster update 
is required. Please note: Each device in the multidrop line needs 
to be allocated 400 to 500 ms per scan cycle, for proper 
scanning. Unless the number of devices in a multidrop line is less 
than 5, it does not help if the scan interval is reduced.
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IP Port 
Property

Description

Scan 
interval

This property indicates the interval at which each device is scanned 
for statu1s change (New alarm or new transactions).

 l Enter 500 in non-multidrop setup

 l Enter 2000 in multidrop setup

NOTE:  This value makes sure that the alarms are reported from 
each device within 5 seconds. Decrease the value if faster update 
is required. Please note: Each device in the multidrop line needs 
to be allocated 400 to 500 ms per scan cycle, for proper 
scanning. Unless the number of devices in a multidrop line is less 
than 5, it does not help if the scan interval is reduced.

 5. Click Apply to save the settings.

8.2.2  Changing the Value of IP Port Properties
To change the value of one or more properties of an IP port, perform the following 
steps:

 1. In the site tree, select the IP port for which you want to change the value of one 
or more properties.

The properties of the selected IP port are displayed.

 2. Change the value of the property or properties.

 3. Click Apply to save the changes.

8.2.3  Renaming an IP Port
To rename an IP port, perform the following steps:

 1. In the site tree, select the IP port you want to rename.

The name of the selected IP port is highlighted.

 2. From the Edit menu, select Rename.
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The Element name window is displayed.

NOTE:  You can also right-click the name of the IP port in the site tree, and 
then select Rename. 

 3. Enter the new name of the IP port.

 4. Click OK.

8.2.4  Deleting an IP Port

NOTE:  If an IP port has one or more loading bays linked to it, you first have to 
delete these loading bays before you can delete the IP port.

To delete an IP port from a site, perform the following steps:

 1. In the site tree, select the IP port you want to delete.

The name of the IP port is highlighted.

 2. From the Edit menu, select Delete.

The following message is displayed:

 3. Click OK if you want to delete the IP Port. Otherwise, click Cancel.

The IP port is deleted from the site.

NOTE:  You can also right-click the name of the IP port in the site tree, and then 
select Delete.
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 8.3  Creating and Maintaining a Loading Bay
When you created a COM port or an IP port, you can create one or more loading 
bays for this COM port or IP port. A loading bay enables you to group devices.

8.3.1  Creating a Loading Bay
To create a loading bay, perform the following steps:

 1. In the site tree, select the COM port or IP port for which you want to create a 
loading bay.

The name of the selected COM port or IP port is highlighted.

 2. From the Edit menu, select Create Loading Bay.

The Element name window is displayed.

NOTE:  You can also right-click the name of the COM port or IP port in the 
site tree, and then select Create Loading Bay.

NOTE:  Ensure that you do not enter a “.” in the Element name box.

 3. Enter the name of the loading bay and then click OK.
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The loading bay is created and displayed in the site tree.

8.3.2  Renaming a Loading Bay 
To rename a loading bay, perform the following steps:

 1. In the site tree, select the loading bay you want to rename.

The name of the selected loading bay is highlighted.

 2. From the Edit menu, select Rename.

The Element name window is displayed.

NOTE:  You can also right-click the name of the loading bay in the site tree, 
and then select Rename....

 3. Enter the new name of the loading bay and then click OK.

The loading bay is renamed.

8.3.3  Deleting a Loading Bay

NOTE:  If a loading bay has one or more devices linked to it, you first have to 
delete these devices before you can delete the loading bay.
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To delete a loading bay from a com port or an IP port, perform the following steps:

 1. In the site tree, select the loading bay you want to delete.

The name of the selected loading bay is highlighted.

 2. From the Edit menu, select Delete.

The following message is displayed:

 3. Click OK if you want to delete the loading bay. Otherwise, click Cancel.

The loading bay is deleted from the COM port.

NOTE:  You can also right-click the name of the loading bay in the site tree, and 
then select Delete.

 8.4  Creating, Configuring and Maintaining a 
1010CB

After you create a loading bay, you can create one or more 1010CBs for this loading 
bay.

8.4.1  Creating a 1010CB
To create a 1010CB, perform the following steps:

 1. In the site tree, select the loading bay for which you want to create a 1010CB.

The name of the loading bay is highlighted.
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NOTE:  The 1010CB protocol differs from the protocol for Single stream 
controllers and Multi-stream controllers. Therefore, a 1010CB should not be 
linked to the same loading bay (COM port) as Single stream controllers and 
Multi-stream controllers.

 2. From the Edit menu, select Create 1010CB.

The Element name window is displayed.

NOTE:  You can also right-click the name of the loading bay in the site tree, 
and then select Create 1010CB.

NOTE:  Ensure that you do not enter a “.” in the Element name box.

 3. Enter the name of the 1010CB and then click OK.

NOTE:  If the 1010CB is used in a swing arm configuration, i.e. the device is 
used across two loading bays, the names should indicate this. For example 
‘SWING1’, ‘SWING2’.

The 1010CB is created.
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 4. Enter the properties of the 1010CB. The properties are described in the 
following table.

Table 8-3: Description of 1010CB properties

Property Description
Device 
address

The communication address of the 1010CB (1 ... 31).

Scan 
enabled

 l Select True to enable the scan function (communication with this 
device is allowed).

 l Select False to disable the scan function (communication with this 
device is not allowed).

W&M 
enabled

 l Select True if Weights & Measures (W&M) is enabled (the 1010CB 
is W&M compliant).

 l Select False if Weights & Measures (W&M) is not enabled (the 
1010CB is not W&M compliant).

NOTE:  In a W&M compliant system, you always select True, 
except when the 1010CB concerned is non-W&M compliant.
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Property Description

Print 
Enabled

 l Select True to enable the print transaction function. When the 
print transaction function is enabled, the transactions of the 
connected 1010CB are printed immediately and automatically 
resulting in a Bill of Lading.

NOTE:  On the Site Properties tab the printing options for BoL 
(Bill of Lading) have to be set to ‘Print to printer’ or to ‘Print to 
file’. See Section 6.2.1: Printing reports to file for more 
information.

 l Select False to disable the print transaction function.

NOTE:  Regardless of whether you selected True or False, you can 
always print the transactions of the connected 1010CB using the 
Print BoL application.
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Property Description

Sales 
Code

The maximum number of external OPC clients which can be 
connected to the OPC server concurrently is determined by the 
customer order and reflected in the sales code.

 l A = One arm loading

 l B = One arm loading with ratio blending

 l C = One arm loading with side stream blending

 l D = Two arm loading

 l E = Two arm loading: one straight loading, one with ratio 
blending

 l F = Two arm loading: one straight loading, one with side stream 
Blending

 l G = Two arm loading each with ratio blending

 l H = Two arm loading each with side stream blending

 l J = Four arm loading

NOTE:  The selected sales code must match the sales code of the 
connected device.

NOTE:  When there is no communication with a device (e.g. the device is not 
active or there is a problem with the device), disable the scan function for 
this device.

 5. Click Apply to save the properties.

8.4.2  Changing the Value of 1010CB Properties
To change the value of one or more properties of a 1010CB, perform the following 
steps:

 1. In the site tree, select the 1010CB for which you want to change the value of one 
or more properties.
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The name of the 1010CB is highlighted. The properties of the selected 1010CB 
are displayed.

 2. Change the value of the property or properties.

 3. Click Apply to save the changes.

8.4.3  Renaming a 1010CB
To rename a 1010CB, perform the following steps:

 1. In the site tree, select the 1010CB you want to rename.

The name of the 1010CB is highlighted.

 2. From the Edit menu, select Rename.

The Element name window is displayed.

NOTE:  You can also right-click the name of the 1010CB in the site tree, and 
then select Rename from the menu.

 3. Enter the new name of the 1010CB and then click OK.

The 1010CB is renamed.

8.4.4  Deleting a 1010CB
To delete a 1010CB from a loading bay, perform the following steps:

 1. In the site tree, select the 1010CB you want to delete.

The name of the 1010CB is highlighted.

 2. From the Edit menu, select Delete.

The following message is displayed:
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 3. Click OK if you want to delete the 1010CB. Otherwise, click Cancel.

The 1010CB is deleted from the loading bay.

NOTE:  You can also right-click the name of the 1010CB in the site tree, and then 
select Delete from the menu.

 8.5  Creating, Configuring and Maintaining 
SSC-A

When you automatically discover the site, the devices configured for the site are 
automatically displayed in the site tree panel. However, you can also manually 
configure SSC-A devices, if required.

NOTE:  If you manually configure the devices, you must automatically discover 
the devices to use the live viewer, configuration, and diagnostics features.

8.5.1  Creating SSC-A
To create an SSC-A, perform the following steps:

 1. In the site tree, select the loading bay for which you want to create an SSC-A.

The name of the loading bay is highlighted.

NOTE:  The communication protocol used by the SSC-A for communications 
through serial port differs from the communication protocol used by the 
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1010CB. Therefore, SSC-As should not be linked to the same loading bay as 
1010CBs.

 2. From the Edit menu, select Create SSC Additive.

The Element name window is displayed.

NOTES:

 l You can also right-click the name of the loading bay in the site tree, and 
then select Create SSC Additive.

 l Ensure that you do not enter a “.” in the Element name box.

 3. Enter the name of the SSC-A and then click OK.

The SSC-A is created

8.5.2  Changing the Value of SSC-A Properties
To change the value of one or more properties of an SSC-A, perform the following 
steps:

 1. In the site tree, select the SSC-A for which you want to change the value of one 
or more properties.

The name of the SSC-A is highlighted.
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 2. Under Application Configuration, click Portal Properties.

The Portal Properties window is displayed.

 3. Enter the properties of the SSC-A. The properties are described in the following 
table.
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Table 8-4: Description of SSC-A properties

Property Description
FlexConn 
address

The communication address of the SSC-A (0 - 1899).

Scan 
enabled

 l Select True to enable the scan function (communication with this 
device is allowed).

 l Select False to disable the scan function (communication with 
this device is not allowed).

WM 
enabled

Additive transactions need not be W&M compliant. Therefore, the 
default value is ‘False’. You cannot change this value.

Print 
enabled

 l Select True to enable the print transaction function. When the 
print transaction function is enabled, the transactions of the 
connected SSC-As are buffered and printed automatically when 
one print page is full.

NOTE:  On the Site Properties tab the printing options for 
Transaction summary have to be set to ‘Print to printer’ or to 
‘Print to file’. See Table 6-3: Description of Report Settings for 
more information.

 l Select False to disable the print transaction function.

NOTE:  Regardless of whether you selected True or False, you 
can always print the transactions of the connected SSC-A using 
the Print BoL application.

Write 
access 
password

Indicates the password required to update the write-protected 
entities/parameters of the device. 

NOTE:  The password of the device interface must match the 
value specified in this field.

NOTE:  When there is no communication with a device (e.g. the device is not 
active or there is a problem with the device), disable the scan function for 
this device.
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 4. Click Apply to save the changes.

The portal properties for SSC-A are saved.

8.5.3  Renaming an SSC-A
To rename an SSC-A, perform the following steps:

 1. In the site tree, select the SSC-A you want to rename.

The name of the SSC-A is highlighted.

 2. From the Edit menu, select Rename.

The Element name window is displayed.

NOTE:  You can also right-click the name of the SSC-A in the site tree, and 
then select Rename from the menu.

 3. Enter the new name of the SSC-A and then click OK.

The SSC-A is renamed.

8.5.4  Deleting an SSC-A
To delete an SSC-A from a loading bay, perform the following steps:

 1. In the site tree, select the SSC-A you want to delete.

The name of the SSC-A is highlighted.

 2. From the Edit menu, select Delete.

The following message is displayed:
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 3. Click OK if you want to delete the SSC-A. Otherwise, click Cancel.

The SSC-A is deleted from the loading bay.

NOTE:  You can also right-click the name of the SSC-A in the site tree, and then 
select Delete from the menu.

 8.6  Creating, Configuring and Maintaining 
SSC-B

When you automatically discover the site, the devices configured for the site are 
automatically displayed in the site tree panel. However, you can also manually 
configure SSC-B devices, if required.

NOTE:  If you manually configure the devices, you must automatically discover 
the devices to use the live viewer, configuration, and diagnostics features.

8.6.1  Creating SSC-B
To create an SSC-B, perform the following steps:

 1. In the site tree, select the loading bay for which you want to create an SSC-B.

The name of the loading bay is highlighted.

NOTE:  The communication protocol used by the SSC-B for communications 
through serial port differs from the communication protocol used by the 
1010CB. Therefore, SSC-Bs should not be linked to the same loading bay as 
1010CBs.

 2. From the Edit menu, select Create SSC Blending.

The Element name window is displayed.

NOTE:  You can also right-click the name of the loading bay in the site tree, 
and then select Create SSC Blending.
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Ensure that you do not enter a “.” in the Element name box.                 

 3. Enter the name of the SSC-B and then click OK.

The SSC-B is created.

NOTE:  When there is no communication with a device (e.g. the device is not 
active or there is a problem with the device), disable the scan function for 
this device.

 4. Click Apply to save the properties.

8.6.2  Changing the Value of SSC-B Properties
To change the value of one or more properties of an SSC-B, perform the following 
steps:

 1. In the site tree, select the SSC-B for which you want to change the value of one 
or more properties.

The name of the SSC-B is highlighted. 

 2. Under Application Configuration, click Portal Properties.
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The Portal Properties window is displayed. 

 3. Enter the properties of the SSC-B. The properties are described in the following 
table.

Table 8-5: Description of SSC-B properties

Property Description
FlexConn address The communication address of the SSC-B (0 - 1899).

Scan enabled

 l Select True to enable the scan function 
(communication with this device is allowed).

 l Select False to disable the scan function 
(communication with this device is not allowed).
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Property Description

WM enabled

 l Select True if Weights & Measures (W&M) is 
enabled (i.e. the SSC-B is W&M compliant).

 l Select False if Weights & Measures (W&M) is not 
enabled (i.e. the SSC-B is not W&M compliant).

NOTE:  In a W&M compliant system you always 
select True, except when the SSC-B concerned is 
non-W&M compliant.

Print enabled

 l Select True to enable the print transaction 
function. When the print transaction function is 
enabled, the transactions of the connected SSC-B 
are printed immediately and automatically 
resulting in a Bill of Lading .

NOTE:  On the Site Properties tab the printing 
options for BoL (Bill of Lading) have to be set 
to ‘Print to printer’ or to ‘Print to file’. See 
Section 6.2.1: Printing reports to file for more 
information.

 l Select False to disable the print transaction 
function.

NOTE:  Regardless of whether you selected True 
or False, you can always print the transactions of 
the connected SSC-B using the Print BoL 
application.

Write access password

Indicates the password required to update the 
write-protected entities/parameters of the device. 

NOTE:  The password of the device interface 
must match the value specified in this field.
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NOTE:  When there is no communication with a device (e.g. the device is not 
active or there is a problem with the device), disable the scan function for 
this device.

 4. Click Apply to save the changes.

The portal properties forSSC-A are saved.

8.6.3  Renaming an SSC-B
To rename an SSC-B, perform the following steps:

 1. In the site tree select the SSC-B you want to rename.

The name of the SSC-B is highlighted.

 2. From the Edit menu, select Rename.

The Element name window is displayed.

NOTE:  You can also right-click the name of the SSC-B in the site tree, and 
then select Rename from the menu.

 3. Enter the new name of the SSC-B. Then click OK.

The SSC-B is renamed.

8.6.4  Deleting an SSC-B
To delete an SSC-B from a loading bay, perform the following steps:

 1. In the site tree, select the SSC-B you want to delete.

The name of the SSC-B is highlighted.

 2. From the Edit menu, select Delete.

The following message is displayed:
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 3. Click OK if you want to delete the SSC-B. Otherwise, click Cancel.

The SSC-B is deleted from the loading bay.

NOTE:  You can also right-click the name of the SSC-B in the site tree, and then 
select Delete from the menu.

 8.7  Creating, Configuring and Maintaining 
MSC-A

When you automatically discover the site, the devices configured for the site are 
automatically displayed in the site tree panel. However, you can also manually 
configure MSC-A devices, if required.

NOTE:  If you manually configure the devices, you must automatically discover 
the devices to use the live viewer, configuration, and diagnostics features.

8.7.1  Creating MSC-A
To create an MSC-A, perform the following steps:

 1. In the site tree, select the loading bay for which you want to create an MSC-A.

The name of the loading bay is highlighted.

NOTE:  The Multi-stream controller protocol differs from the 1010CB 
protocol. Therefore, an MSC-A should not be linked to the same loading bay 
(COM port) as 1010CBs.

 2. From the Edit menu, select Create MSC Additive.
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The Element name window is displayed.

NOTE:  You can also right-click the name of the loading bay in the site tree, 
and then select Create MSC Additive.

Ensure that you do not enter a “.” in the Element name box.         

 3. Enter the name of the MSC-A and then click OK.

The MSC-A is created.

8.7.2  Changing the Value of MSC-A Properties
To change the value of one or more properties of an MSC-A, perform the following 
steps:

 1. In the site tree, select the MSC-A for which you want to change the value of one 
or more properties.

The name of the MSC-A is highlighted. 

 2. Under Application Configuration, click Portal Properties.

The Portal Properties window is displayed.

Fusion4 Portal Installation & Operation Manual

8  Portal Settings | 112



 3. Enter the properties of the MSC-A. 

Table 8-6: Description of MSC-A properties

Property Description
FlexConn 
address

The communication address of the MSC-A (0 - 1899).

Scan 
enabled

 l Select True to enable the scan function (communication with this 
device is allowed).

 l Select False to disable the scan function (communication with 
this device is not allowed).

WM 
enabled

Additive transactions need not be W&M compliant. Therefore, the 
default value is ‘False’. You cannot change this value.
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Property Description

Print 
enabled

 l Select True to enable the print transaction function. When the 
print transaction function is enabled, the transactions of the 
connected MSC-A are buffered and printed automatically when 
one print page is full.

NOTE:  On the Site Properties tab the printing options for 
Transaction summary have to be set to ‘Print to printer’ or to 
‘Print to file’. See Section 6.2.1: Printing reports to file for 
more information.

 l Select False to disable the print transaction function.

NOTE:  Regardless of whether you selected True or False, you 
can always print the transactions of the connected MSC-A using 
the Print BoL application.

Write 
access 
password

Indicates the password required to update the write-protected 
entities/parameters of the device. 

NOTE:  The password of the device interface must match the 
value specified in this field. 

NOTE:  When there is no communication with a device (e.g. the device is not 
active or there is a problem with the device), disable the scan function for 
this device.

 4. Click Apply to save the changes.

The portal properties for MSC-A is saved.

8.7.3  Renaming an MSC-A
To rename an MSC-A, perform the following steps:

 1. In the site tree select the MSC-A you want to rename.

The name of the MSC-A is highlighted.
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 2. From the Edit menu, select Rename.

The Element name window is displayed.

NOTE:  You can also right-click the name of the MSC-A in the site tree, and 
then select Rename... from the menu.

 3. Enter the new name of the MSC-A and then click OK.

The MSC-A is renamed.

8.7.4  Deleting an MSC-A
To delete an MSC-A from a loading bay, perform the following steps:

 1. In the site tree select the MSC-A you want to delete.

The name of the MSC-A is highlighted.

 2. From the Edit menu, select Delete.

NOTE:  You can also right-click the name of the MSC-A in the site tree, and 
then select Delete from the menu.

The following message is displayed:

 3. Click OK if you want to delete the MSC-A. Otherwise, click Cancel.

The MSC-A is deleted from the loading bay.
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 8.8  Creating, Configuring and Maintaining 
MSC-L

When you automatically discover the site, the devices configured for the site are 
automatically displayed in the site tree panel. However, you can also manually 
configure MSC-L devices, if required.

NOTE:  If you manually configure the devices, you must automatically discover 
the devices to use the live viewer, configuration, and diagnostics features.

8.8.1  Creating MSC-L
To create an MSC-L, perform the following steps:

 1. In the site tree, select the loading bay for which you want to create an MSC-L.

The name of the loading bay is highlighted.

NOTE:  The Multi-stream controller protocol differs from the 1010CB 
protocol. Therefore, an MSC-L should not be linked to the same loading bay 
(COM port) as 1010CBs.

 2. From the Edit menu, select Create MSC Loading.

The Element name window is displayed.

NOTE:  You can also right-click the name of the loading bay in the site tree, 
and then select Create MSC Loading.

NOTE:  Ensure that you do not enter a “.” in the Element name box.
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 3. Enter the name of the MSC-L and then click OK.

The MSC-L is created.

8.8.2  Changing the Value of MSC-L Properties
To change the value of one or more properties of an MSC-L, perform the following 
steps:

 1. In the site tree, select the MSC-L for which you want to change the value of one 
or more properties.

The name of the MSC-L is highlighted. 

 2. Under Application Configuration, click Portal Properties.

The Portal Properties window is displayed.
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 3. Enter the properties of the MSC-L. 

Table 8-7: Description of MSC-L properties

Property Description
FlexConn address The communication address of the MSC-L (0 - 1899).

Scan enabled

 l Select True to enable the scan function 
(communication with this device is allowed).

 l Select False to disable the scan function 
(communication with this device is not allowed).

WM enabled
Loading transactions need not be W&M compliant. 
Therefore, the default value is ‘False’. However, you 
can change this value to ‘True’, if required.
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Property Description

Print enabled

 l Select True to enable the print transaction 
function. 

NOTE:  In the Reports tab, the printing 
options for BOL have to be set to ‘Print to 
printer’ or to ‘Print to file’. See Table 6-3: 
Description of Report Settings for more 
information.

 l Select False to disable the print transaction 
function.

NOTE:  Regardless of whether you selected True 
or False, you can always print the transactions of 
the connected MSC-L using the Print BoL 
application.

Write access password

Indicates the password required to update the 
write-protected entities/parameters of the device. 

NOTE:  The password of the device interface 
must match the value specified in this field. 

NOTE:  When there is no communication with a device (e.g. the device is not 
active or there is a problem with the device), disable the scan function for 
this device.

 4. Click Apply to save the changes.

The portal properties for MSC-L is saved.

8.8.3  Renaming an MSC-L
To rename an MSC-L, perform the following steps:

 1. In the site tree, select the MSC-L you want to rename.

The name of the MSC-L is highlighted.
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 2. From the Edit menu, select Rename.

The Element name - Fusion4 Portal window is displayed.

NOTE:  You can also right-click the name of the MSC-L in the site tree, and 
then select Rename... from the menu.

 3. Enter the new name of the MSC-L and then click OK.

The MSC-L is renamed.

8.8.4  Deleting an MSC-L
To delete an MSC-L from a loading bay, perform the following steps:

 1. In the site tree, select the MSC-L you want to delete.

The name of the MSC-L is highlighted.

 2. From the Edit menu, select Delete.

NOTE:  You can also right-click the name of the MSC-L in the site tree, and 
then select Delete from the menu.

The following message is displayed:

 3. Click OK if you want to delete the MSC-L. Otherwise, click Cancel.

The MSC-L is deleted from the loading bay.
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 8.9  Restarting the Computer
When you have configured Fusion4 Portal, you have to shutdown and restart the 
computer.

 8.10  Replacing the Logo on the Bill of Lading
You can replace the default with the logo of your company.

NOTE:  The logo used must be a bitmap file (.bmp). You can use, for example, 
Microsoft Windows Paint to create a new bitmap file. The preferred size of the 
logo is: 234 pixels (width) x 46 pixels (height) with a resolution of 96 dpi. The 
name of this bitmap file must be CompanyLogo.bmp.

To replace the logo, perform the following steps:

 1. Save the bitmap file containing the logo of your company in the directories that 
contain the original CompanyLogo.bmp file:

...\Program Files\Enraf\Fusion4 Portal\BoL Printer

...\Program Files\Enraf\Fusion4 Portal\Monitor

The original bitmap file is overwritten by the new bitmap file containing the logo 
of your company.

 2. Shut down and restart the computer.

NOTE:  On the BoL printout, the new logo is scaled automatically to let it fit in 
the reserved area on the BoL.
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9  Configure Module
You can remotely configure devices such as SSC-A, SSC-B, MSC-A, and MSC-L using 
the Fusion4 Portal application. However, you can also configure these settings on 
the real devices.

The following menu items are available as part of all the device configuration 
pages.

Fields Description
Apply Data Allows you to apply the settings.
Get Data Allows you to get the current values from the device.
Last read 
time

Allows you to view the time when the current values from the device 
were last read.

Undo Cancel the applied settings.
Live Viewer 

Remotely monitor the current loading details of the device.

NOTE:  You can remotely configure devices in the Fusion4 Portal application if 
these devices are auto discovered (Refer ). 

 9.1  Configuring SSC-A
You can configure parameters for an SSC-A device and additive streams for the 
selected SSC-A device.

To configure parameters for an SSC-A device, perform the following steps:

 1. In the site tree, select the SSC-A device that you want to configure.

 2. From the menu bar, click the CONFIGURATION tab.

The Configuration window for the selected SSC-A device is displayed.

Fusion4 Portal Installation & Operation Manual

9  Configure Module | 122



 3. Click Device.

The Device window is displayed.

 4. Under Device, click Identification.

The Identification window is displayed with various parameters.
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 5. Enter the details for the required parameters. 

CAUTION:  If the Fusion4 Portal is unable to get or apply data, an error 
message is displayed.

 6. Click Apply Data to apply these settings.

 7. Repeat the above steps to configure various parameters under Device and IO 
Settings.

The SSC-A device configuration is complete.

9.1.1  Configuring SSC-A Additive Stream
The SSC-A device has only one additive stream. You can configure parameters for 
the additive stream of an SSC-A device. The additive stream is displayed when you 
perform the “Auto-Discover” operation.

To configure an SSC-A additive stream, perform the following steps:

 1. In the site tree, select the additive stream that you want to configure, under the 
SSC-A device.

 2. From the menu bar, click the CONFIGURATION tab.
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The Configuration window for the selected additive stream is displayed, with 
various settings such as I/O Binding, Control Settings, Volume conversion, and 
Alarms.

 3. Click I/O Binding.

The I/O Binding window is displayed with settings namely Inputs and Outputs.

 4. Click Inputs.

The Inputs window is displayed with various settings.
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 5. Enter the details for the required fields.  

CAUTION:  If the Fusion4 Portal is unable to get or apply data, an error 
message is displayed.

 6. Click Apply Data to apply these settings.

 7. Repeat the above steps to configure various settings for the additive stream.

The configuration of the additive stream for the SSC-A device is complete.

 9.2  Configuring SSC-B
You can configure parameters for an SSC-B device and product streams for the 
selected SSC-B device.

To configure parameters for an SSC-B device, perform the following steps:
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 1. In the site tree, select the SSC-B device that you want to configure.

 2. From the menu bar, click the CONFIGURATION tab.

The Configuration window for the selected SSC-B device is displayed.

 3. Click Device Configuration.

The Device Configuration window is displayed.
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 4. Under Device, click Identification.

The Identification window is displayed with various parameters.

 5. Enter the details for the required parameters. 

CAUTION:  If the Fusion4 Portal is unable to get or apply data, an error 
message is displayed.

 6. Click Apply Data to apply these settings.

 7. Repeat the above steps to configure various parameters under Device and IO 
Settings.

The SSC-B device configuration is complete.

9.2.1  Configuring SSC-B Product Stream
The SSC-B device has only one product stream. You can configure parameters for 
the product stream of an SSC-B device. The product streams is displayed when you 
perform the “Auto-Discover” operation.

To configure an SSC-B product stream, perform the following steps:
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 1. In the site tree, select the product stream that you want to configure, under the 
SSC-B device.

 2. From the menu bar, click the CONFIGURATION tab.

The Configuration window for the selected product stream is displayed, with 
various settings such as Identification, I/O Binding, Control Settings, and Alarms.

 3. Click I/O Binding.

The I/O Binding window is displayed with settings namely Inputs and Outputs.

 4. Click Inputs.

The Inputs window is displayed with various settings.
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 5. Enter the details for the required fields. 

CAUTION:  If the Fusion4 Portal is unable to get or apply data, an error 
message is displayed.

 6. Click Apply Data to apply these settings.

 7. Repeat the above steps to configure various settings for the product stream.

The configuration of the product stream for the SSC-B device is complete.

 9.3  Configuring MSC-A
You can configure parameters for an MSC-A device, additive streams, arms, and 
product streams for the selected MSC-A device.

To configure parameters for an MSC-A device, perform the following steps:
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 1. In the site tree, select the MSC-A device that you want to configure.

 2. From the menu bar, click the CONFIGURATION tab.

The Configuration window for the selected MSC-A device is displayed.

 3. Click Identification.

The Identification window is displayed with various parameters.
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 4. Enter the details for the required parameters.

CAUTION:  If the Fusion4 Portal is unable to get or apply data, an error 
message is displayed.

 5. Click Apply Data to apply these settings.

 6. Repeat the above steps to configure other parameters.

The MSC-A device configuration is complete.

9.3.1  Configuring MSC-A Additive Stream
You can configure parameters for additive streams of an MSC-A device. The 
number of additive streams depends on the license of the MSC-A device. The 
additive streams are displayed when you perform the “Auto-Discover” operation.

To configure an MSC-A additive stream, perform the following steps:

 1. In the site tree, select the additive stream that you want to configure, under the 
MSC-A device.

 2. From the menu bar, click the CONFIGURATION tab.

The Configuration window for the selected additive stream is displayed, with 
various settings such as Identification, I/O Binding, Control Settings, and Alarms.
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 3. Click Identification.

The Identification window is displayed with various settings.
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 4. Enter the details for the required fields.

CAUTION:  If the Fusion4 Portal is unable to get or apply data, an error 
message is displayed.

 5. Click Apply Data to apply these settings.

 6. Repeat the above steps to configure various settings for the additive stream.

The configuration of the additive stream for the MSC-A device is complete.

 9.4  Configuring MSC-L
You can configure parameters for an MSC-L device, additive streams, arms, and 
product streams for the selected MSC-L device.

To configure parameters for an MSC-L device, perform the following steps:

 1. In the site tree, select the MSC-L device that you want to configure.

 2. Click the CONFIGURATION tab.
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The Configuration window for the selected MSC-L device is displayed.

 3. Click Device Configuration.

The Device Configuration window is displayed.
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 4. Under Device Configuration, click General.

The General window is displayed with various settings.

 5. Under General, click Identification.

The Identification window is displayed with various parameters.
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 6. Enter the details for the required parameters. 

CAUTION:  If the Fusion4 Portal is unable to get or apply data, an error 
message is displayed.

 7. Click Apply Data to apply these settings.

 8. Repeat the above steps to configure various parameters under Device 
Configuration and Bay Configuration.

The MSC-L device configuration is complete.

9.4.1  Configuring MSC-L Additive Stream
You can configure parameters for additive streams of an MSC-L device. The 
number of additive streams depends on the license of the MSC-L device. The 
additive streams are displayed when you perform the “Auto-Discover” operation.

To configure an MSC-L additive stream, perform the following steps:

 1. In the site tree, select the additive stream that you want to configure, under the 
MSC-L device.
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 2. From the menu bar, click the CONFIGURATION tab.

The Configuration window for the selected additive stream is displayed, with 
various settings such as Identification, I/O Binding, Control Settings, and Alarms.

 3. Click Identification.

The Identification window is displayed with various settings.

 4. Enter the details for the required fields.
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CAUTION:  If the Fusion4 Portal is unable to get or apply data, an error 
message is displayed.

 5. Click Apply Data to apply these settings.

 6. Repeat the above steps to configure various settings for the additive stream.

The configuration of the additive stream for the MSC-L device is complete.

9.4.2  Configuring MSC-L Arm
You can configure parameters for arms of an MSC-L device. The number of arms 
depends on the license of the MSC-L device. The arms are displayed when you 
perform the “Auto-Discover” operation.

To configure an MSC-L arm, perform the following steps:

 1. In the site tree, select the arm that you want to configure, under the MSC-L 
device.

 2. From the menu bar, click the CONFIGURATION tab.

The Configuration window for the selected arm is displayed with various 
settings such as Identification, I/O Binding, Control Settings, and Alarms.

 3. Click Identification.
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The Identification window is displayed with various settings.

 4. Enter the details for the required fields.

CAUTION:  If the Fusion4 Portal is unable to get or apply data, an error 
message is displayed.

 5. Click Apply Data to apply these settings.

 6. Repeat the above steps to configure various settings for the arm.

The configuration of the arm for the MSC-L device is complete.

9.4.3  Configuring MSC-L Product Stream
You can configure parameters for product stream of an MSC-L device. The number 
of product streams depends on the license of the MSC-L device. The product 
streams are displayed when you perform the “Auto-Discover” operation.

To configure an MSC-L product stream, perform the following steps:

 1. In the site tree, select the product stream that you want to configure, under the 
MSC-L device.

 2. From the menu bar, click the CONFIGURATION tab.
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The Configuration window for the selected product stream is displayed, with 
various settings such as Identification, I/O Binding, Control Settings, and Alarms.

 3. Click Identification.

The Identification window is displayed with various settings.
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 4. Enter the details for the required fields.

CAUTION:  If the Fusion4 Portal is unable to get or apply data, an error 
message is displayed.

 5. Click Apply Data to apply these settings.

 6. Repeat the above steps to configure various settings for the product stream.

The configuration of the product stream for the MSC-L device is complete.

9.4.4  Configure Authorization
You can remotely configure the authorization database available in a MSC-L device 
through the Fusion4 Portal application.

9.4.5  Configure Authorization Setup
You can configure details such as the authorization mode and the type. 

To configure setup authorization, perform the following steps:

 1. In the site tree, select the device for which you want to configure authorization.

 2. Choose Edit > Configure authorization.

Or

Right-click the device and then select Configure authorization.

The Authorization dialog box is displayed.
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 3. Under Authorization, click Setup.

The following dialog box is displayed.

 4. From the Authorization mode drop-down list, select one of the following:

 l No verification: If you do not want to validate the user and/or loading details 
with the local/remote database.
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 l Local verification: If you want to validate the user and/or loading details with 
the local database.

 l Remote verification: If you want to validate the user and/or loading details 
with the remote database.

 5. From the Authorization type drop-down list, select one of the following:

 l None: If you do not want to validate the user or loading details.       

 l Pin: If you want to validate the user and/or loading details using PIN.

 l NexWatch: If you want to validate the user and/or loading details using 
NexWatch card.

 l Nedap: If you want to validate the user and/or loading details using Nedap 
RFID.

 6. Click Apply Data to apply these settings.

The authorization setup configurations are complete.

9.4.6  Configure User Database Authorization
You can manage users using this option. When you create or update a user, the 
database is updated.

To authorize user database, perform the following steps:

 1. In the site tree, select the device for which you want to configure authorization.

 2. Choose Edit > Configure authorization.

Or

Right-click the device and then select Configure authorization.

The Authorization dialog box is displayed.
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 3. Under Authorization, click Databases.

The following dialog box is displayed.

 4. Click User database.

The following dialog box is displayed.
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 5. Perform the following:

 a. In the Name box, type the name of the driver in the MSC-L transaction. The 
maximum length of the name is 16 characters.

 b. In the Passcode box, type the passcode of the user database. Ensure that 
the passcode is unique for each user. The maximum length of the passcode 
is 10 characters.

 c. From the Type drop-down list, select the type of the user database. The 
available options are SL1, SL2, SL3, and None. SL represents the security 
levels where, SL1 has minimal privileges and SL3 has maximum privileges. 
You must select ‘None’ if you want to remove a user from the database.

The Error Text box displays the details error messages, if any, for the user.

 6. Repeat step 5 for other user databases as applicable.

 7. Click Apply Data to apply these settings.

The configuration of user database authorization is complete.
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9.4.7  Configure Objects Database Authorization
You can manage objects using this option. When you create or update an object, 
the database is updated.

To authorize object database, perform the following steps:

 1. In the site tree, select the device for which you want to configure authorization.

 2. Choose Edit > Configure authorization.

Or

Right-click the device and then select Configure authorization.

The Authorization dialog box is displayed.

 3. Under Authorization, click Databases.

The following dialog box is displayed.
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 4. Click Objects database.

The following dialog box is displayed.

 5. Perform the following:
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 a. In the Name box, type the name of the object i.e Vehicle, Carrier, Trailer, and 
Contract in the MSC-L transaction.      The maximum length of the object is 16 
characters.

 b. In the Passcode box, type the passcode of the objects database.       Ensure that 
the passcode is unique for each user. The maximum length of the passcode 
is 10 characters. 

 c. From the Type drop-down list, select the type of the object. For The available 
options are Vehicle, Carrier, Trailer, Contract, and None.  You must select 
‘None’ if you want to remove an object from the database.

In the Error Text box,       displays the details error messages, if any, for the 
objects.

 6. Repeat step 5 for other objects databases as applicable.

 7. Click Apply Data to apply these settings.

The configuration of objects database authorization is complete.

9.4.8  Archive authorization
You can save the authorizations of setup, users, and/or objects of a MSC-L device 
and later replicate these configurations in other MSC-L devices. The options to 
archive and upload configurations reduce the configuration time required at the 
site

To archive authorization, perform the following steps:

 1. In the site tree, select the device whose authorization you want to archive.

 2. Choose Edit > Archive authorization.

Or

Right-click the device and then select Archive authorization.

The Archive authorization dialog box is displayed with the details of the selected 
device name and type.
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 3. Click Read device data to archive the data stored in the real device.

Or

Click Read portal stored data to archive the data stored in the Fusion4 Portal 
application.

The Save As dialog box is displayed.

 4. Type the name of the XML file and then click Save.

A message appears indicating that the XML file is created at the selected path.

9.4.9  Upload authorization
You can upload the details of setup, users, and/or objects that are already archived.

To upload authorization, perform the following steps:

 1. In the site tree, select the device whose authorization you want to upload.

 2. Choose Edit > Upload authorization.

Or

Right-click the device and then select Upload authorization.

The Open dialog box is displayed.

 3. Choose the XML file where you want to upload the authorization. Ensure that 
you select the XML file with appropriate license.

 4. Click Open.

The Upload authorization window is displayed.
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 5. Click Upload.

The following message is displayed.

 6. Click Yes.

The configurations are successfully uploaded.

 9.5  Archive Configurations
You can save the configurations of a device and later replicate these configurations 
in other devices. The options to archive and upload configurations reduce the 
configuration time required at the site.

NOTE:  You cannot archive the communication parameters using this option.
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To archive configuration, perform the following steps:

 1. In the site tree, select the device whose configuration you want to archive.

 2. Right-click the device and then select Archive Configuration.

The Archive configuration dialog box is displayed with the details of the selected 
device name and type.

 3. Click Read device data to archive the data stored in the real device.

Or

Click Read portal stored data to archive the data stored in the Fusion4 Portal 
application.

The Save As dialog box is displayed.

 4. Type the name of the XML file and then click Save.

A message appears indicating that the XML file is created at the selected path.

 9.6  Upload Configurations
You can upload the details of devices that are already archived.

NOTE:  You cannot upload the communication parameters using this option.

To upload configuration, perform the following steps:

 1. In the site tree, select the device whose configuration you want to upload.

 2. Choose Edit > Upload Configuration.
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Or

Right-click the device and then select Upload Configuration.

The Open dialog box is displayed.

 3. Choose the XML file where you want to upload the configurations. Ensure that 
you select the XML file with appropriate license.

 4. Click Open.

The Upload configuration window is displayed.

The following details are displayed by default.

 l Device name: The name of the device whose configuration you want to 
upload.

 l Device type: The type of device selected.

 l Configuration group: The configuration group whose details you want to 
upload.

 l Parameter: The parameter name.
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 l New Value: The new value of the parameter.

 l Unit: The unit in which the parameter is measured.

 l Error Message: The error message corresponding to the parameter.

 5. In the Upload list, select the check box corresponding to the configuration 
groups and parameters whose details you want to upload.

 6. Click Upload.

The following message is displayed.

 7. Click Yes.

The configurations are successfully uploaded.
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10  Monitor Module
CAUTION:  Do not shutdown Fusion4 Portal when transactions are taking place, 
since this disrupts the automatic printing process. The transactions are stored 
on the hard disk though, so you can retrieve and print them using the Print BoL 
application.

 10.1  Transactions in Fusion4 Portal
Fusion4 Portal enables you to view completed device transactions. By default, the 
transactions that are completed within the last 24 hours are automatically 
displayed in the list of transactions. In addition, you can search for transactions that 
were completed on a specific date or within a specific period of time, and/or that 
match certain search criteria.

NOTE:  The Fusion4 Portal application retrieves transactions of a device if the 
serial number is configured appropriately in the real device. 

10.1.1  Viewing Transactions in Real Time
To view completed transactions, perform the following steps:

 1. In Fusion4 Portal, click the TRANSACTIONS tab.

The Transactions panel is displayed.
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 2. In the site tree panel, select the site, COM port, IP port, loading bay, or device 
(1010CB, SSC-A, SSC-B, MSC-A, MSC-L) for which you want to view the completed 
transactions.

The name of the site, COM port, loading bay, or device is highlighted. For the 
selected site, COM port, loading bay, or device, the completed transactions are 
displayed in the list of transactions.

 3. To view the details of a transaction:

 a. From the list of transactions, select the transaction of which you want to view 
the details.

The selected transaction is highlighted.

NOTE:  You can select more than one transaction at a time. When 
selecting more than one transaction, keep the following in mind: You can 
view/print 25 SSC-A and/or MSC-A transactions or one Bill of Lading 
(1010CB, SSC-B, MSC-L) at a time. To select two or more transactions, 
press and hold the [Ctrl] key on your keyboard and select the 
transactions. To select two or more successive transactions, you can also 
press and hold the [Shift] key on your keyboard and select the first and 
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the last transaction. To select all transactions in the list press and hold 
the [Ctrl] key and subsequently press [A] on your keyboard.

 b. Click View.

The details of the selected transaction(s) are displayed in the View Report 
window.

The following figure represents the first and second pages of the MSC-L BOL 
report.
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 4. Click  to close the View Report window. You will return to Fusion4 Portal.
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NOTES:

 1. By default, the Auto Refresh option is enabled unless it was disabled 
manually earlier.

If the Auto Refresh icon is displayed as , the list of transactions displays 
transactions that were completed in the last 24-25 hours. 

If the Auto Refresh icon is displayed as , the list of transaction is 
temporarily not refreshed and the search options are available.

 2. You can search for transactions that were completed on a specific date or 
within a specific time period, and/or that match certain search criteria. 
Subsequently, you can view the details of these transactions. See section  for 
more information. 

 3. You can only view transactions on the Transactions panel. If you want to 
print one or more transactions, you can use the Print BoL application.

 10.2  Searching for Completed Transactions
Fusion4 Portal enables you to search for transactions that were completed on a 
specific date or within a specific period, and/or that match certain search criteria. 
Subsequently, you can view the details of these transactions.

To search for completed transactions, perform the following steps:

 1. In Fusion4 Portal, click the Transactions tab.

The Transactions panel is displayed.
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 2. Click  to disable the Auto Refresh option.

The Search options become available.

 3. In the Date From entry fields, select the start date and enter the start time of the 
period for which you want to view completed transactions.

Fusion4 Portal Installation & Operation Manual

10  Monitor Module | 160



 l You can select the start date by clicking the “arrow down” button and then 
selecting the date from the pop-up calendar. Use the “arrow left” button and 
the “arrow right” button to go the previous or next month respectively.

 l You can specify the start time by entering the time using the keyboard. You 
can also use the “arrow up” button and the “arrow down” button to change 
the time.

 4. In the To entry fields, select the end date and enter the end time of the period 
for which you want to view completed transactions.

 l You can select the end date by clicking the “arrow down” button and then 
selecting the date from the pop-up calendar. Use the “arrow left” button and 
the “arrow right” button to go the previous or next month respectively.

 l You can specify the end time by entering the time using your keyboard. You 
can also use the “arrow up” button and the “arrow down” button to change 
the time.

NOTE:  The search period of time between the start date and time and the 
end date and time can be maximum one month.

The retention period of time for completed transactions is one year, i.e. you 
can search for transactions that were completed maximum one year ago.

 5. If you are searching for a specific completed transaction and you know the ID of 
this transaction, enter the ID in the Transaction ID entry field.

NOTE:  You can use ‘?’ (substitutes one character) and ‘*’ (substitutes any 
number of characters) as wild cards in your search.

 6. If you are searching for transactions that involved the transfer of a specific 
product, enter the product name in the Product entry field.

NOTE:  You can use ‘?’ (substitutes one character) and ‘*’ (substitutes any 
number of characters) as wild cards in your search.

 7. Click View Transactions.
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All transactions that were completed within the selected time period and that 
match the search criteria are displayed in the list of transactions.

 8. From the list of transactions select the transaction you want to view.

The selected transaction is highlighted.

NOTE:  You can select more than one transaction at a time. When selecting 
more than one transaction keep the following in mind: You can view/print 25 
SSC-A and/or MSC-A transactions or one Bill of Lading (1010CB, SSC-B, MSC-
L) at a time. To select two or more transactions, press and hold the [Ctrl] key 
on your keyboard and select the transactions. To select two or more 
successive transactions, you can also press and hold the [Shift] key on your 
keyboard and select the first and the last transaction. To select all 
transactions in the list press and hold the [Ctrl] key and subsequently press 
[A] on your keyboard.

 9. Click View.

The details of the selected transaction(s) are displayed in the View Report 
window.
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 10. Click  to close the View Report window. You will return to the Fusion4 Portal.

 10.3  Monitoring Alarms
Fusion4 Portal features an alarm panel that enables you to monitor the alarms that 
are detected on the connected devices.

The Alarm panel can be divided into two sections:

 l List of active alarms 

 l Alarm control buttons 

10.3.1  List of Active Alarms
The Alarm panel displays a list of active alarms in chronological order with the 
newest alarms on top of the list.

For each alarm that is listed in the active alarm list the following details are 
displayed (see ).

NOTE:  Fusion4 Portal displays only alarms that are detected on Fusion4 
devices, i.e. SSC-As, SSC-Bs, MSC-As, and MSC-Ls.

Table 10-1: Description of alarm details

Item Description

Status

 Alarm asserted (Active)

 Alarm reset requested

 Alarm acknowledged

 Alarm acknowledge requested
Date and 
time

Displays the date (Year-Month-Day) and time (Hour:Minutes:Seconds) 
the alarm was detected on the device.

Bay
Displays the name of the loading bay associated with the device on 
which the alarm was detected. The displayed name is the name as 
configured in Fusion4 Portal.
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Item Description

Arm
Displays the number of the loading arm associated with the device on 
which the alarm was detected. The displayed number is the number 
as configured in Fusion4 Portal.

Device
Displays the name of the device on which the alarm was detected. 
The displayed name is the name as configured in Fusion4 Portal.

Description

Displays a description of the alarm like device communication alarms 
and alarm which has occurred on the device (like device alarm and 
stream alarms).

In case of a device communication alarm due to an invalid or no 
response from a device or an invalid or lost connection with a device, 
serial line or Ethernet port, Fusion4 Portal displays one of the 
following descriptions (in English):

 l 1. Communication error

NOTE:  This results from line noise or line problems.

 l 2. Time out

NOTE:  This results from line failure or device problems.

 l 3. Connection error

NOTE:  This results from terminal server or port failure.

NOTE:  Communications alarms are displayed in the English 
language, irrespective of the language that was selected in the 
device. All other alarms are displayed in the language selected in 
the device.
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Item Description

Alarm State

Displays the current state of the alarm:

 l Active
This alarm state indicates that the alarm is active.

 l Acknowledged
This alarm state indicates that the alarm has been acknowledged

 l Request Acknowledge
This alarm state indicates that a request for acknowledgment of 
the alarm is pending

 l Request Reset
This alarm state indicates that a request for reset of the alarm is 
pending

NOTE:  The alarm states ‘Active’ and ‘Acknowledged’ originate 
from the device and follow the language that is selected in the 
device. The alarm states ‘Request Acknowledge’ and ‘Request 
Reset’ are in English irrespective of the language that was 
selected in the device.

Stream

Displays the name of the stream associated with the device on which 
the alarm was detected.

For example: AddStrm1, AddStrm2, ProdStrm1, ProdStrm2

10.3.2  Alarm Control Buttons
The following table describes the alarm control buttons.

   
Button Description

Alarm 
Counters

Displays the number of active alarms on the Alarm panel.

Displays the number of acknowledged alarms on the Alarm 
panel.
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Alarm 
Annunciation

Enables or disables audio annunciation. When audio 
annunciation is enabled, a beep sounds from the computer when a 
new alarm is detected.

Reset device

Resets the alarm or alarms that were selected in the list of active 
alarms, and all other alarms detected on the device(s) associated 
with the selected alarm(s).

The name of the device associated with an alarm is displayed in the 
column ‘Device name’.

Reset stream

Resets the alarm or alarms that were selected in the list of active 
alarms, and all other alarms detected on the stream associated with 
the selected alarm(s).

The name of the stream associated with an alarm is displayed in the 
column ‘Stream’.

Reset
Resets the alarm or alarms that were selected in the list of active 
alarms.

Acknowledge
Acknowledges the alarm or alarms that were selected in the list of 
active alarms.

 10.4  Live Viewer
You can view the loading details of the Fusion4 devices, which are connected via 
Serial or Ethernet ports, to the Fusion4 Portal machine.

The live viewer replicates the loading details of the device screen, thereby enabling 
you to remotely monitor the device.
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NOTES

 l The Live Viewer feature is applicable only for Fusion4 devices, and not for 
1010CB device.                                 

 l The Live Viewer feature is available only if the auto-discover operation is 
performed.                 

 l Guidant recommends you to use the Live Viewer feature when the value of 
the baud rate is 9600 or more.

 l Only one instance of Live Viewer can be viewed at a time.

10.4.1  Viewing loading details of SSC-A
 1. Start Fusion4 Portal.

 2. In the site tree, select the name of the SSC-A device whose details you want to 
view.

The following window is displayed.
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 3. Right-click the device and then click Live Viewer.

The Live Viewer dialog box is displayed.

The following details are displayed.

 l Compartment: The trailer compartment associated with this batch.

 l Recipe name: The recipe used during the batch (name, blend %, API symbol).
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 l Load GOV: The gross observed volume of the finished product being loaded.

 l Remaining qty: The remaining quality of the finished product that is yet to be 
loaded.

 l Flow rate: The actual flow rate.

10.4.2  Viewing loading details of SSC-B
 1. Start Fusion4 Portal.

 2. In the site tree, select the name of the SSC-B device whose details you want to 
view.

The following window is displayed.

 3. Right-click the device and then click Live Viewer.

The Live Viewer window is displayed.
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The following details are displayed.

 l Location: The location in the site where the SSC-B device is installed.

 l Product name: The icon of the product being loaded.

 l Target Blend %: The desired percentage of target blend for the loaded 
product.

 l Current Blend %: The actual percentage of current blend for the loaded 
product.

 l Blend Volume: The gross observed volume of blended product.

 l Load Volume: The gross observed volume of loaded product.

10.4.3  Viewing loading details of MSC-A
 1. Start Fusion4 Portal.

 2. In the site tree, select the name of the MSC-A device whose details you want to 
view.

The following window is displayed.
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 3. Right-click the device and then click Live Viewer.

The Live Viewer dialog box is displayed.

The following details are displayed.
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 l Location: The location in the site where the MSC-A device is installed.

 l Product name: The icon of the product being loaded.

 l Additive mode: The mode in which the additive was injected.

 l Deviation: The percentage of deviation from the target additive

 l injection volume.

 l ppm: The actual calculated parts per million of the additive in the

 l final product.

 l Additive Volume: The amount of injection volume dispensed per injection 
cycle.

 l Load Volume: The total wild stream volume moved during the transaction.

10.4.4  Viewing loading details of MSC-L
 1. Start Fusion4 Portal.

 2. In the site tree, select the name of the MSC-L device whose details you want to 
view.

The following window is displayed.
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 3. Right-click the device and then click Live Viewer.

The Live Viewer dialog box is displayed.

The following details are displayed.

 l Compartment: The number of the compartment to which the batch was 
transferred.
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 l Recipe name: The recipe used during the batch (name, blend %, API symbol).

NOTE:  By default, Load GOV, Remaining qty, and Flow rate parameters along 
with their respective units configured in the MSC-L device are displayed. 
However, you can configure the last 3 operation parameters displayed on the 
Live Viewer screen in the MSC-L device. 

Fusion4 Portal Installation & Operation Manual

10  Monitor Module | 174



11  Print Module
 11.1  Printing BoL

You can view and/or print a report using this option. When you choose to print, the 
report is printed using the default printer configured for the user. However, you 
can change the printer using which you want to print the reports.

Perform the following steps:

 1. Choose Start > All Programs > Enraf > Fusion4 Portal.

The Fusion4 Portal window is displayed.

 2. Choose Print > Print BoL.

The Print BoL window is displayed.

When you select a transaction, the Print option is enabled.

 3. Choose File > Print.

The Print dialog box is displayed.
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 4. From the Name drop-down list, select the printer using which you want to print 
the BOL reports.

 5. Click OK.

The selected printer is considered as the default printer for printing the BOL 
reports.

 11.2  Transactions in Print BoL
The Print BoL application enables you to view and print completed transactions that 
are a stored on the hard disk. By default, if a transaction is completed it is 
automatically displayed in the list of transactions. However, you can also search for 
transactions that were completed on a specific date or within a specific period of 
time, and/or that match certain search criteria.

11.2.1  Viewing/Printing transactions
To view and print a transaction that is retrieved from the Fusion4 Portal application, 
perform the following steps:

 1. Start Print BoL.

 a. From the Start menu, select All Programs | Enraf | Print BoL.

The Print BoL main window is displayed.
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 2. In the site tree panel, select the site, COM port, IP port, loading bay, or device 
(1010 CB, SSC-A, SSC-B, MSC-A, MSC-L) for which you want to view the 
completed transactions.

The name of the site, COM port, loading bay, or device is highlighted. For the 
selected site, COM port, loading bay or device the completed transactions are 
displayed in the list of transactions. Transactions that were completed within the 
last 24 hours are displayed by default.

 3. To view the details of a transaction:

 a. From the list of transactions, select the transaction for which you want to 
view the details.

The selected transaction is highlighted.

NOTE:  You can select more than one transaction at a time. When 
selecting more than one transaction keep the following in mind: You can 
view/print 25 SSC-A and/or MSC-A transactions or one Bill of Lading 
(1010CB, SSC-B, MSC-L) at a time. To select two or more transactions, 
press and hold the [Ctrl] key on your keyboard and select the 
transactions. To select two or more successive transactions, you can also 
press and hold the [Shift] key on your keyboard and select the first and 
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the last transaction. To select all transactions in the list press and hold 
the [Ctrl] key and subsequently press [A] on your keyboard.

 b. Click View.

The details of the selected transaction(s) are displayed in the View Report 
window.

The following figure represents the first and second pages of the BOL 
report.
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 4. Click  to close the View Report window. You will return to the Fusion4 Portal 
application.

 5. Click Print to print the details of the selected transaction.

11.2.2  Viewing/Printing Additive Summary Reports
You can view additive summary reports using the Fusion4 Portal and/or Print BoL 
applications.

To view the additive summary reports, perform the following steps:

 1. Choose Reports > Additive Summary Report.

The Additive Summary Report dialog box is displayed.

 2. Under Select a date range, elect the start and end dates and also select the start 
and end time for which you want to view additive summary reports.

 l You can select the date by clicking the “arrow down” button and then 
selecting the date from the pop-up calendar. Use the “arrow left” button and 
the “arrow right” button to go the previous or next month respectively.

 l You can specify the time by entering the time using the keyboard. You can 
also use the “arrow up” button and the “arrow down” button to change the 
time.

NOTE:  The search period of time between the start date and time and the 
end date and time can be maximum one month.

The retention period of time for reports is one year, i.e. you can search for 
reports that were completed maximum one year ago.

 3. Click OK.
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The additive summary report is displayed in the View Report window.

 l Click  to print the additive summary report.

 l Click  to close the View Report window. You will return to Fusion4 Portal.

11.2.3  Viewing/Printing Blend Summary Report
You can view blend summary reports using the Fusion4 Portal and/or Print BoL 
applications.

To view the blend summary reports, perform the following steps:

 1. Choose Reports > Blend Summary Report.

The Blend Summary Report dialog box is displayed.
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 2. Under Select a date range, select the start and end dates and also select the 
start and end time for which you want to view blend summary reports.

 l You can select the date by clicking the “arrow down” button and then 
selecting the date from the pop-up calendar. Use the “arrow left” button and 
the “arrow right” button to go the previous or next month respectively.

 l You can specify the time by entering the time using the keyboard. You can 
also use the “arrow up” button and the “arrow down” button to change the 
time.

NOTE:  The search period of time between the start date and time and the 
end date and time can be maximum one month.

The retention period of time for reports is one year, i.e. you can search for 
reports that were completed maximum one year ago.

 3. Click OK.

The blend summary report is displayed in the View Report window.
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 l Click  to print the blend summary report.

 l Click  to close the View Report window. You will return to Fusion4 Portal.

11.2.4  Searching for Retrieved Transactions 
The Print BoL application enables you to search for transactions that were 
completed and stored on hard disk on a specific date or within a specific period of 
time, and that match certain search criteria. Subsequently, you can view and print 
the details of these transactions.

 1. Start Print BoL.

The Print BoL window is displayed.
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 2. Click  to automatically refresh the search options.

The Search options become available.

 3. In the Date From entry fields, select the start date and enter the start time of the 
time period for which you want to view the completed and stored transactions.
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 l You can select the start date by clicking the “arrow down” button and then 
selecting the date from the pop-up calendar. Use the “arrow left” button and 
the “arrow right” button to go the previous or next month respectively.

 l You can specify the start time by entering the time using the keyboard. You 
can also use the “arrow up” button and the “arrow down” button to change 
the time.

 4. In the To entry fields, select the end date and enter the end time of the time 
period for which you want to view the completed and stored transactions.

 l You can select the end date by clicking the “arrow down” button and then 
selecting the date from the pop-up calendar. Use the “arrow left” button and 
the “arrow right” button to go the previous or next month respectively.

 l You can specify the end time by entering the time using your keyboard. You 
can also use the “arrow up” button and the “arrow down” button to change 
the time.

NOTE:  The search period of time between the start date and time and the 
end date and time can be maximum one month.

The retention period of time for completed transactions is one year, i.e. you 
can search for transactions that were completed and stored maximum one 
year ago.

 5. If you know the ID of the stored transaction that you are searching for, enter 
this ID in the Transaction ID entry field.

 6. If you know which product was transferred during the stored transaction you 
are searching for, enter the name of this product in the Product entry field.

 7. Click View Transactions.

All completed transactions that were stored on the specified date or within the 
specified period of time, and that match the search criteria are displayed in the 
transaction list.

 8. From the list of stored transactions select the transaction you want to view.

The selected transaction is highlighted.
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NOTE:  You can select more than one transaction at a time. When selecting 
more than one transaction keep the following in mind: You can view/print 25 
SSC-A and/or MSC-A transactions or one Bill of Lading (1010CB, SSC-B, MSC-
L) at a time. To select two or more transactions, press and hold the [Ctrl] key 
on your keyboard and select the transactions. To select two or more 
successive transactions, you can also press and hold the [Shift] key on your 
keyboard and select the first and the last transaction. To select all 
transactions in the list press and hold the [Ctrl] key and subsequently press 
[A] on your keyboard.

 9. Click View to view the details of the selected transaction(s).

The details of the selected transaction(s) are displayed in the View Report 
window.

 10. Click  to close the View Report window. You will return to the Print BoL 
window.

 11. Click Print to print the details of the selected transactions.

Fusion4 Portal Installation & Operation Manual

11  Print Module | 185



 11.3  1010CBBill of Lading
The following figure illustrates a sample Bill of Lading for a 1010CB device.

Figure 1: Example of Bill of Lading for 1010CB

 1. Bill of Lading header (see Section 11.3.1: Bill of Lading Header)

 2. Compartment Total Indication table (see Section 11.3.2: Compartment Total 
Indication)

 3. Batch Specifications table (see Section 11.3.3: Batch Specifications)

 4. Status Legend table (see Section 11.3.4: Status Legend)

11.3.1  Bill of Lading Header
The header of the Bill of Lading displays the following information (see the 
following table):
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Table 11-1: Example of information on Bill of Lading Header

Item Description
[site name] Displays the name of the site on which the transaction took place.

Transaction
Displays the transaction ID. This ID consists of 28 characters, and 
comprises the device type followed by a serial number and a 
unique number.

Order/Contract Displays the ID of the contract for this transaction.
vehicle id Displays the ID of vehicle used for the transaction.
driver id Displays the ID of the driver responsible for the transaction.
Start Displays the date and time when the transaction started.
Stop Displays the date and time when the transaction stopped.

[loading bay]
Displays the ID of the loading bay in which the transaction took 
place.

device Displays the ID of the device on which the transaction took place.
calibration no. Displays the calibration number applicable to the transaction.
Printed by 
Fusion4 Portal

Displays the date on which the BoL was printed.

[page number] Displays the current page number and page total.

11.3.1.1  BoL Logo
The logo is displayed at the top right-hand side. This logo can be replaced by the 
logo of your company. Refer to Section 8.10: Replacing the Logo on the Bill of 
Lading  for more information.

11.3.2  Compartment Total Indication
The Compartment total indication table displays for each compartment information 
about the batch that was transferred during the transaction (see the following 
table).

Table 11-2: Description of items in Compartment total indication table

Item Description

Comp.
Displays the number of the compartment to which the batch was 
transferred.
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Item Description
Product Displays the name of the product that was transferred.

Contents
Displays the total Gross Observed Volume of the batch or batches 
that was/were transferred to the compartment.

ADR 
Classification

Displays the ADR Classification for the batch that was transferred. It 
consists of:

UN number and proper shipping name
UN numbers are four-digit numbers that identify hazardous 
substances and articles. The UN numbers are assigned by the 
United Nations Committee of Experts on the Transport of 
Dangerous Goods. Associated with each UN number is a hazard 
identifier (ADR class)

ADR class
ADR (Accord européen relatief au transport international de 
marchandises Dangereuses par Route) is an European agreement 
concerning the international carriage of dangerous goods by road. 
The ADR divides dangerous goods into the following classes:

 l Class 1: Explosive substances and articles
 l Class 2: Gases
 l Class 3: Flammable liquids
 l Class 4.1: Flammable solids, self-reactive substances and solid 

desensitized explosives
 l Class 4.2: Substances liable to spontaneous combustion
 l Class 4.3: Substances which, in contact with water, emit 

flammable gases
 l Class 5.1: Oxidizing substances
 l Class 5.2: Organic peroxides
 l Class 6.1: Toxic substances
 l Class 6.2: Infectious substances
 l Class 7: Radioactive material
 l Class 8: Corrosive substances
 l Class 9: Miscellaneous dangerous substances and articles
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Item Description

Batch Alarm

When there is a disturbance during the transfer of a batch to a 
compartment, the system generates an alarm. The number of this 
alarm is displayed in the Batch Alarm column (see Section 13.3: 
Device (1010CB) Error Status Codes).

Weights & 
Measures

If the system is W&M approved, the Weights & Measures column 
displays whether the transfer of a batch was W&M compliant or non 
W&M compliant.

If the system is not W&M approved, this column is empty.

11.3.3  Batch Specifications
The table under Batch specifications displays the following information for each 
batch (the following table).

Table 11-3: Description of items in batch specification table

Item Description
A Displays the id of the arm that was used to transfer the product.
C Displays the compartment to which the product was transferred.
Stream Displays the name of the main stream or blend stream.

Ratio
Displays the percentage of the blend product in the total 
transferred stream.

Preset Displays the preset volume (GOV) or mass.

GOV
Displays the Gross Observed Volume of the product that was 
transferred, i.e. the real transferred volume, not corrected for 
temperature or pressure effects on the volume.

GSV

Displays the Gross Standard Volume of the product that was 
transferred, i.e. the total volume of all liquids corrected by the 
appropriate volume correction factor for the observed temperature, 
density and pressure.

Mass Displays the mass of the product that was transferred.
Average 
temperature

Displays the average temperature of the product that was 
transferred.
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Item Description
Average 
pressure

Displays the average pressure of the liquid during the time that the 
product was transferred.

Average 
density

Displays the average density of the product that was transferred.

Table + 
comm. 
group

Displays the table name and commodity group that are used for the 
GSV calculation. The table name refers to used tables or algorithms 
in an API standard. The following product classes can be 
distinguished:

“-” = No commodity group selected

A = Crude oil

B = Refined products

C = Lubricating oils

D = Special applications

E = NGL (= natural gas liquid) and 

LPG (= liquefied petroleum gas)

F = Fatty Acid Methyl Esters

Press corr
Displays whether pressure correction was On or Off during the 
transfer of the product.

11.3.4  Status Legend
The table under the status legend describes the markings used, if applicable, to 
indicate the status of the information on the Bill of Lading.

 11.4  Additive Transaction Summary
The following figure illustrates a sample additive transaction summary.
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Figure 2: Example of Additive transaction summary

 1. Additive transaction summary header (see Section 11.4.1: List of Transaction 
Data Header)

 2. Additive transactions table (see Section 11.4.2: Additive Transactions)

 3. Status Legend table (see Section 11.4.3: Status Legend)

11.4.1  List of Transaction Data Header
The Additive transaction summary header shows the following information (see the 
following table).

Table 11-4: Description of information on list of transaction data header

Item Description
Printed by Fusion4 
Portal

Displays the date on which the list of transactions was 
printed.

Page Displays the current page number and page total.
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Item Description

Site name
Displays the name of the site on which the transaction took 
place.

11.4.1.1  List of Transaction Data Logo
The logo is displayed at the top right-hand side. This logo can be replaced by the 
logo of your company. Refer to section  for more information.

11.4.2  Additive Transactions
The table under Additive transactions lists the SSC-A transactions that were 
selected in the Print BoL window. For each transaction, the following information is 
shown (see the following table).

Table 11-5: Description of items in additive transactions table

Item Description
Device id Displays the ID of the SSC-A device that was used for the transaction.

Transaction 
No.

Displays the transaction ID. This ID consists of 28 characters, and 
comprises the device type followed by a serial number and a unique 
number.

Delivered Displays the date and time when the transaction took place.

Bay
Displays the ID of the loading bay on which the transaction took 
place.

Arm Displays the id of the arm that was used to transfer the product.
Product Displays the name of the product that was transferred.
Load 
Volume

The total wild (and additive) stream volume moved during the 
transaction.

Additive 
Volume

The total observed volume of additive product dispensed during the 
batch.

Ratio
The actual calculated parts per million of the additive in the final 
product.

Deviation The percentage deviation from the target additive injection volume.

Fault
Contains “ERROR” or “-”. For a list of alarms, see the SSC-A Installation 
and Operation Manual.
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11.4.3  Status Legend
The table under the status legend describes the markings used, if applicable, to 
indicate the status of the data on the list of transaction data.

 11.5  Bill of Lading for SSC-B
The following figure illustrates a sample Bill of Lading for SSC-B device.
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Figure 3: Example of Bill of Lading for SSC-B

 1. Bill of Lading header (see Section 11.5.1: Bill of Lading Header)

 2. Transaction data table (see Section 11.5.2: Transaction Data)

 3. Accumulated totals table (see Section 11.5.3: Accumulated Totals)

 4. Status Legend table (see Section 11.5.4: Status Legend)
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11.5.1  Bill of Lading Header
The Bill of Lading header displays the following information (see the following 
table):

Table 11-6: Description of information on Bill of Lading Header

Item Description

Printed by Fusion4 Portal
Displays the date on which the Bill of Lading was 
printed.

Page Displays the current page number and page total.

Transaction
Displays the transaction ID. This ID consists of 28 
characters, and comprises the device type followed by 
a serial number and a unique number.

Blend product (down-
stream)

Displays the name of the blend product that was 
transferred.

Actual blend rate (GOV)
Displays the percentage of blend product (GOV) in the 
delivered end product (GOV).

Site name
Displays the name of the site on which the transaction 
took place.

Bay
Displays the ID of the loading bay on which the 
transaction took place.

Device identification
Displays the ID of the SSC-B device that was used for 
the transaction.

Transaction start
Displays the date and time when the transaction 
started.

Transaction stop
Displays the date and time when the transaction 
stopped.
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Item Description

ADR Classification

Displays the ADR Classification for the batch that was 
transferred. It consists of:

UN number and proper shipping name
UN numbers are four-digit numbers that identify 
hazardous substances and articles. The UN numbers 
are assigned by the United Nations Committee of 
Experts on the Transport of Dangerous Goods. 
Associated with each UN number is a hazard identifier 
(ADR class)

ADR class
ADR (Accord européen relatief au transport 
international de marchandises Dangereuses par Route) 
is an European agreement concerning the 
international carriage of dangerous goods by road. The 
ADR divides dangerous goods into the following 
classes:

 l Class 1: Explosive substances and articles
 l Class 2: Gases
 l Class 3: Flammable liquids
 l Class 4.1: Flammable solids, self-reactive substances 

and solid desensitized explosives
 l Class 4.2: Substances liable to spontaneous 

combustion
 l Class 4.3: Substances which, in contact with water, 

emit flammable gases
 l Class 5.1: Oxidizing substances
 l Class 5.2: Organic peroxides
 l Class 6.1: Toxic substances
 l Class 6.2: Infectious substances
 l Class 7: Radioactive material
 l Class 8: Corrosive substances
 l Class 9: Miscellaneous dangerous substances and 

articles
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Item Description

Arm
Displays the ID of the loading arm that was used to 
transfer the product.

11.5.1.1  Bill of Lading Logo
The logo is displayed at the top right-hand side. This logo can be replaced by the 
logo of your company. Refer to Section 8.10: Replacing the Logo on the Bill of 
Lading  for more information.

11.5.2  Transaction Data
The table under Transaction data displays the following information.

Table 11-7: Description of information in Transaction data table

Item Description
Gross 
Observed 
Volume

Displays the Gross Observed Volume of the product that was 
transferred, i.e. the real transferred volume, not corrected for 
temperature or pressure effects on the volume.

Gross 
Standard 
Volume

Displays the Gross Standard Volume of the product that was 
transferred, i.e. the total volume of all liquids corrected by the 
appropriate volume correction factor for the observed 
temperature, density and pressure.

Mass Displays the mass of the product that was transferred.
Average 
temperature

Displays the average temperature of the product that was 
transferred.

Average 
pressure

Displays the average pressure of the liquid during the time that the 
product was transferred.

Average 
density

Displays the average density of the product that was transferred.

Observed 
density

Displays the observed density that is used to calculate the 
reference density.

Density 
temperature

Displays the temperature at which the observed product density 
was determined.

Density 
pressure

Displays the pressure at which the observed product density was 
determined.
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Item Description

Standard

Displays the volume correction method used during the 
transaction for the blend product. It consists of a table 
identification.

Available tables are:

 l “-” (No table)
 l 5/6
 l 23/24
 l 53/54
 l 59/60

Commodity 
group

Displays the table name and commodity group that are used for 
the GSV calculation. The table name refers to used tables or 
algorithms in an API standard. The following product classes can 
be distinguished:

 l “-” = No commodity group selected
 l A = Crude oil
 l B = Refined products
 l C = Lubricating oils
 l D = Special applications
 l E = NGL (= natural gas liquid) and LPG (= liquefied petroleum 

gas)
 l F = Fatty Acid Methyl Esters

Base 
temperature

Displays the reference temperature that is used for the volume 
correction.

Base pressure
Displays the reference pressure that is used for the volume 
correction.

Temperature 
compensation

Displays whether temperature compensation was On or Off during 
the transfer of the product.

Pressure 
compensation

Displays whether pressure compensation was On or Off during the 
transfer of the product.

Hydrometer 
correction

Displays whether hydrometer correction was On or Off during the 
transfer of the product.
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11.5.3  Accumulated Totals
The Accumulated totals table displays the following information.

Item Description
Total 
GOV

Displays the accumulated volume at the start or end of the batch. The 
volume is not corrected.

Total 
GSV

Displays the accumulated volume at the start or end of the batch. The 
volume is corrected and calculated for reference conditions.

11.5.4  Status Legend
The table under Status legend describes the markings used, if applicable, to 
indicate the status of the information on the Bill of Lading.

 11.6  Bill of Lading for MSC-L
The following figure illustrates a Bill of Lading for an MSC-L device.
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Figure 11-1: Example of Bill of Lading for MSC-L

 1. Bill of Lading header (see Section 11.6.1: Bill of Lading Header)

 2. Compartment totals table (see Section 11.6.2: Compartment Totals)
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 3. W&M relevant batch specifications table (see Section 11.6.3: W&M relevant 
batch specifications)

 4. Status Legend table (see Section 11.6.4: Status Legend)

11.6.1  Bill of Lading Header
The Bill of Lading header displays the following information (see the following 
table).

Table 11-8: Description of information on Bill of Lading Header

Item Description
Printed by 
Fusion4 Portal

Displays the date on which the Bill of Lading was printed.

Page Displays the current page number and page total.

Transaction
Displays the transaction ID. This ID consists of 28 characters, and 
comprises the device type followed by a serial number and a 
unique number.

Order/contract
Displays the ID of the order or contract for which the transaction 
took place.

Vehicle Displays the ID of the vehicle.
Driver Displays the ID of the driver.

Bay
Displays the ID of the loading bay in which the transaction took 
place.

Site name Displays the name of the site on which the transaction took place.
Start Displays the date and time when the transaction started.
Stop Displays the date and time when the transaction stopped.
Base 
temperature

Displays the reference temperature that is used for the volume 
correction.

Base pressure
Displays the reference pressure that is used for the volume 
correction.

Device
Displays the ID of the device (MSC-L) that was used for the 
transaction.
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11.6.1.1  Bill of Lading Logo
The logo is displayed at the top right-hand side. This logo can be replaced by the 
logo of your company. Refer to section  for more information.

11.6.2  Compartment Totals
The table under Compartment totals displays the following information (see the 
following table).

Table 11-9: Description of information in Compartment totals table

Item Description

Compartment
Displays the number of the compartment to which the batch was 
transferred.

Product Displays the name of the product that was transferred.
Estimated 
Content

Displays the total Gross Observed Volume of the batch or batches 
that was/were transferred to the compartment.
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Item Description

ADR 
Classification

Displays the ADR Classification for the batch that was transferred. It 
consists of:

UN number and proper shipping name
UN numbers are four-digit numbers that identify hazardous 
substances and articles. The UN numbers are assigned by the 
United Nations Committee of Experts on the Transport of 
Dangerous Goods. Associated with each UN number is a hazard 
identifier (ADR class)

ADR class
ADR (Accord européen relatief au transport international de 
marchandises Dangereuses par Route) is an European agreement 
concerning the international carriage of dangerous goods by road. 
The ADR divides dangerous goods into the following classes:

 l Class 1: Explosive substances and articles
 l Class 2: Gases
 l Class 3: Flammable liquids
 l Class 4.1: Flammable solids, self-reactive substances and solid 

desensitized explosives
 l Class 4.2: Substances liable to spontaneous combustion
 l Class 4.3: Substances which, in contact with water, emit 

flammable gases
 l Class 5.1: Oxidizing substances
 l Class 5.2: Organic peroxides
 l Class 6.1: Toxic substances
 l Class 6.2: Infectious substances
 l Class 7: Radioactive material
 l Class 8: Corrosive substances
 l Class 9: Miscellaneous dangerous substances and articles

Remarks Displays any additional details about the transaction.
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11.6.3  W&M relevant batch specifications
The W&M relevant batch specifications table displays the following information (see 
the following table).

Table 11-10: Description of items in W&M relevant batch specifications

Item Description

Arm & comp.
Displays the ID of the loading arm that was used to transfer the 
product. Also displays the compartment to which the batch was 
transferred.

Product Displays the name of the products that were transferred.

Recipe & 
preset

Displays the recipe and the preset volume (GOV) or mass.

The recipe configured on the MSC-L device controls the rate of 
additive being injected into the product stream.

Preset indicates the preset quantity for the batch. 

Actual ratio
Displays the percentage of the main/blend product in the total 
transferred stream.

Gross 
Standard 
Volume 
(GSV)

Displays the Gross Standard Volume of the product that

was transferred, i.e. the total volume of all liquids corrected by the 
appropriate volume correction factor for the observed temperature, 
density and pressure.

Gross 
Observed 
Volume 
(GOV)

Displays the Gross Observed Volume of the product that was 
transferred, i.e. the real transferred volume, not corrected for 
temperature or pressure effects on the volume.

Mass Displays the mass of the product that was transferred.
Average 
temperature

Displays the average temperature of the product that was 
transferred.

Average 
pressure

Displays the average pressure of the liquid during the time that the 
product was transferred.

Average 
density

Displays the average density of the product that was transferred.
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Item Description
Pressure 
corr

Displays whether pressure correction was On or Off during the 
transfer of the product.

Commodity 
group

Displays the table name and commodity group that are used for the 
GSV calculation. The table name refers to used tables or algorithms 
in an API standard. The following product classes can be 
distinguished:

 l “0” = No commodity group selected
 l 1 = Crude oil
 l 2 = Refined products
 l 3 = Special apps
 l 4 = Lub oils
 l 5 = NGL (= natural gas liquid) and LPG (= liquefied petroleum gas)
 l 6 = Fatty Acid Methyl Esters

11.6.4  Status Legend
The table under the Status legend describes the markings used, if applicable, to 
indicate the status of the information on the Bill of Lading.
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12  Device Diagnostics
 12.1  Diagnostics

Fusion4 Portal enables you to view the system health and dashboard details of all 
the configured devices.

You can view the diagnostics of the following devices:

 l SSC-A                 

 l SSC-B                 

 l MSC-A                 

 l MSC-L                 

NOTE:  You can view the diagnostics of the devices only if you have discovered 
the devices in the site using the “Auto Discover” feature.

 12.2  Viewing SSC-A Diagnostics
12.2.1  Viewing SSC-A Dashboard Diagnostics

To view the diagnostics of an SSC-A device, perform the following steps:

 1. In the site tree, select the SSC-A device whose diagnostic details you want to 
view.

 2. From the menu bar, click the DIAGNOSTICS tab.

The Diagnostics window for the selected SSC-A device is displayed, with settings 
such as Dashboard and System Health.
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 3. Under Diagnostics, click Dashboard.

The Dashboard window is displayed.
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The following details are displayed by default.

 l IO Name: The name of the Input/Output parameter.

 l Data: The value of the parameter received from the device.

 4. Click Get Data to get the current value from the device.

The Last read time field displays the time when the data was last retrieved from 
the device.

12.2.2  Viewing SSC-A System Health
To view the system health of an SSC-A device, perform the following steps:

 1. In the site tree, select the SSC-A device whose diagnostic details you want to 
view.

 2. From the menu bar, click the DIAGNOSTICS tab.
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The Diagnostics window for the selected SSC-A device is displayed, with settings 
such as Dashboard and System Health.

 3. Under Diagnostics, click System Health.

The System Health window is displayed.
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The following details are displayed by default.

 l Board Name: The health status of the board connected to the selected SSC-A 
device

 l Status: The status of the board

 l StatusCode: The status code of the board

 4. Under Board Name, click any board name to view its system health.

The following window is displayed.
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The following details are displayed by default.

 l FunctionName: The name of the function connected to the selected SSC-A 
device

 l Status: The health status of each board

 l StatusCode: The error message, if any, displayed for the selected board

 5. Click Get Data to get the current value from the device.

The Last read time field displays the time when the data was last retrieved from 
the device.

 12.3  Viewing SSC-B Diagnostics
12.3.1  Viewing SSC-B Dashboard Diagnostics

To view the diagnostics of an SSC-B device, perform the following steps:

 1. In the site tree, select the SSC-B device whose diagnostic details you want to 
view.

 2. From the menu bar, click the DIAGNOSTICS tab.
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The Diagnostics window for the selected SSC-B device is displayed, with settings 
such as Dashboard and System Health.

 3. Under Diagnostics, click Dashboard.

The Dashboard window is displayed.
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The following details are displayed by default.

 l IO Name: The name of the Input/Output parameter

 l Data: The value of the parameter received from the device

 4. Click Get Data to get the current value from the device.

The Last read time field displays the time when the data was last retrieved from 
the device.

12.3.2  Viewing SSC-B System Health
To view the system health of an SSC-B device, perform the following steps:

 1. In the site tree, select the SSC-B device whose diagnostic details you want to 
view.
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 2. From the menu bar, click the DIAGNOSTICS tab.

The Diagnostics window for the selected SSC-B device is displayed, with settings 
such as Dashboard and System Health.

 3. Under Diagnostics, click System Health.

The System Health window is displayed.
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The following details are displayed by default.

 l Board Name: The health status of the board connected to the selected SSC-B 
device

 l Status: The status of the board

 l StatusCode: The status code of the board

 4. Under Board Name, click any board name to view its system health.

The following window is displayed.
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The following details are displayed by default.

 l FunctionName: The name of the function connected to the selected SSC-B 
device

 l Status: The health status of each board

 l StatusCode: The error message, if any, displayed for the selected board

 5. Click Get Data to get the current value from the device.

The Last read time field displays the time when the data was last retrieved from 
the device.

 12.4  Viewing MSC-A Diagnostics
12.4.1  Viewing MSC-A Dashboard Diagnostics

To view the diagnostics of an MSC-A device, perform the following steps:
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 1. In the site tree, select the MSC-A device whose diagnostic details you want to 
view.

 2. From the menu bar, click the DIAGNOSTICS tab.

The Diagnostics window for the selected MSC-A device is displayed, with 
settings such as Dashboard and System Health.

 3. Under Diagnostics, click Dashboard.

The Dashboard window is displayed.
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 4. Click Digital Input.

The following window is displayed.

The following details are displayed by default.
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 l Status: The health status of the parameter

 l IO Name: The name of the Input/Output parameter

 l Data: The value of the parameter received from the device

 5. Click Get Data to get the current value from the device.

The Last read time field displays the time when the data was last retrieved from 
the device.

 6. Repeat the above steps to get data for the other diagnostic parameters.

12.4.2  Viewing MSC-A System Health
To view the system health of an MSC-A device, perform the following steps:

 1. In the site tree, select the MSC-A device whose diagnostic details you want to 
view.

 2. From the menu bar, click the DIAGNOSTICS tab.

The Diagnostics window for the selected MSC-A device is displayed, with 
settings such as Dashboard and System Health.

 3. Under Diagnostics, click System Health.
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The System Health window is displayed.

The following details are displayed by default.

 l Board Name: The health status of the board connected to the selected MSC-
A device

 l Status: The status of the board

 l StatusCode: The status code of the board

 4. Under Board Name, click any board name to view its system health.

The following window is displayed.
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The following details are displayed by default.

 l FunctionName: The name of the function connected to the selected MSC-A 
device

 l Status: The health status of each board

 l StatusCode: The error message, if any, displayed for the selected board

 5. Click Get Data to get the current value from the device.

The Last read time field displays the time when the data was last retrieved from 
the device.

 6. Repeat the above steps to get data for other diagnostic parameters.
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 12.5  Viewing MSC-LDiagnostics
12.5.1  Viewing MSC-LDashboard Diagnostics

To view the diagnostics of an MSC-Ldevice, perform the following steps:

 1. In the site tree, select the MSC-Ldevice whose diagnostic details you want to 
view.

 2. From the menu bar, click the DIAGNOSTICS tab.

The Diagnostics window for the selected MSC-Ldevice is displayed, with settings 
such as Dashboard and System Health.

 3. Under Diagnostics, click Dashboard.

The Dashboard window is displayed.
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 4. Click Digital Input.

The following window is displayed.

The following details are displayed by default.

 l Status: The health status of the parameter

 l IO Name: The name of the Input/Output parameter

 l Data: The value of the parameter received from the device

 5. Click Get Data to get the current value from the device.
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The Last read time field displays the time when the data was last retrieved from 
the device.

 6. Repeat the above steps to get data for other diagnostic parameters.

12.5.2  Viewing MSC-L System Health
To view the system health of an MSC-L device, perform the following steps:

 1. In the site tree, select the MSC-Ldevice whose diagnostic details you want to 
view.

 2. From the menu bar, click the DIAGNOSTICS tab.

The Diagnostics window for the selected MSC-Ldevice is displayed, with settings 
such as Dashboard and System Health.

 3. Under Diagnostics, click System Health.

The System Health window is displayed.
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The following details are displayed by default.

 l Board Name: The health status of the board connected to the selected MSC-
Ldevice

 l Status: The status of the board

 l StatusCode: The status code of the board

 4. Under Board Name, click any board name to view its system health.

The following window is displayed.

The following details are displayed by default.
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 l FunctionName: The name of the function connected to the selected MSC-
Ldevice

 l Status: The health status of each board

 l StatusCode: The error message, if any, displayed for the selected board

 5. Click Get Data to get the current value from the device.

The Last read time field displays the time when the data was last retrieved from 
the device.

 6. Repeat the above steps to get data for other diagnostic parameters.
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13  Portal Diagnostics
 13.1  Logs

Fusion4 Portal enables you to view all events that occurred in Fusion4 Portal and 
that were logged. Furthermore, the logged events can be printed in an event log.

The following events are logged:

 l Alarms

 l Transactions

 l Device resets

 l Device communication status updates

 l Configuration changes of the Portal

 l Configuration changes of a device

 l Events and Calibration Logs

13.1.1  Viewing and Printing Logged Events in Real-time
By default the Auto Refresh option is enabled, which means that the list of logged 
events is automatically updated. You can view and print logged events by 
performing the following steps:

 1. In Fusion4 Portal, click the LOGS tab.

The Logs panel is displayed.
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 2. Click Search options.

The Search options for real-time view are enabled.

 3. Select the type of logged events you want to view and print.

 l Select Application Log to view events logged by the Fusion4 Portal 
applications.

 l Select Audit Log to view logged operational events, i.e. start and shutdown 
of Fusion4 Portal, overwrite command for operational data items such as 
blend percentage and manual densities, finished transaction, recipe update 
(per device), device command, configuration changes, W&M sealing, and 
W&M seal breakage.

 l Select Combined to view events logged by the Fusion4 Portal applications 
and logged operational events.

 4. If necessary, add or remove columns. See Section 13.1.1.1: Adding or Removing 
Columns  for more information.

 5. If necessary, filter the logged events. See Section 13.1.1.2: Filtering Messages  
for more information.

 6. If necessary, print the logged event or events:
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 a. In the list with logged events select the event or events you want to print.

The selected logged event or events are highlighted.

NOTE:  You can select more than one logged event at a time. To select 
two or more logged events, press and hold the [Ctrl] key on your 
keyboard and then select the events. To select two or more successive 
logged events, you can also press and hold the [Shift] key on your 
keyboard and then select the first and the last event. To select all logged 
events displayed in the list, press and hold the [Ctrl] key and then press 
[A] on your keyboard.

 b. Click Print Logs.

An event log is created for the selected event(s) in Crystal Reports. In Crystal 
Reports you can print the event log

 c. Click  to close Crystal Reports.

Fusion4 Portal is displayed again.

 7. If necessary, you can also view events that were logged on a specific date or 
within a specific period. See Section 13.2: Enraf Process Control Center  for more 
information.

13.1.1.1  Adding or Removing Columns
For each logged event that is listed in the Logs panel, the following information is 
displayed by default (see the following table):

Table 13-1: Description of event details displayed by default

Item Description
Item Description
Event time Displays the date and time the event occurred.
Message Displays a description of the event.
Application 
name

Displays the name of the application that logged the event.

Device name
Displays the name of the device on which the logged event 
occurred.
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In addition to this information, you can display extra information by adding 
columns.

 1. In Fusion4 Portal, click the Logs tab.

The Logs panel is displayed.

 2. Click  to select the columns.

The Select Columns dialog box is displayed.
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 3. Select the columns you want to display by selecting the check box displayed 
next to the column name. 

 4. Click Save to save the new settings. If you do not want to save the new settings, 
click Cancel.

The Select Columns window is closed.

The event data shown on the Logs tab is automatically updated.

13.1.1.2  Filtering Messages
You can filter the logged events that are displayed in the Logs panel by defining 
one or more search criteria.

 1. In Fusion4 Portal, click the Logs tab.

The Logs panel is displayed.

 2. Click Search Options.

The search options are displayed.
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 3. Enter the search criteria:

 a. In the Search Text field, enter the text you want to search.

 b. From the Application list box, select the application for which you want to 
view the logged events matching your search criteria. The available 
selections are described in the following table.

Table 13-2: Description of items in Application list box

Item Description

ALL
Displays all logged events matching the search criteria you 
entered in the Search field.

Print on 
Demand

Displays all logged events in the Print BoL application.

Fusion4 
Portal          

Displays all events logged by Fusion4 Portal matching the search 
criteria you entered in the Search field.

Fusion4 
Server

Displays all events logged by the scan.

EPCC
Displays all events logged by the Enraf Process Control Center 
matching the search criteria you entered in the Search field.

BoL 
Printer

Displays all events logged by the BoL Printer application matching 
the search criteria you entered in the Search field.
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 c. From the Columns list box, select the name of the column to be 
searched.The available selections are described in the following table.

Table 13-3: Description of items in Columns list box

Item Description
Item Description
Event time Filters on event time.
Message Filters on message.
Application name Filters on application name.
Device name Filters on device name.

 4. In the From entry fields, select the start date and enter the start time of the 
period for which you want to search the logged events.

 l You can select the start date by clicking the “arrow down” button and then 
selecting the date from the pop-up calendar. Use the “arrow left” and “arrow 
right” buttons to go the previous or next month respectively.

 l You can specify the start time by entering the time using the keyboard. You 
can also use the “arrow up” and “arrow down” buttons to change the time.

 5. In the To entry fields, select the end date and enter the end time of the period 
for which you want to search the logged events.

 l You can select the end date by clicking the “arrow down” button and then 
selecting the date from the pop-up calendar. Use the “arrow left” and “arrow 
right” buttons to go the previous or next month respectively.

 l You can specify the end time by entering the time using your keyboard. You 
can also use the “arrow up” and “arrow down” buttons to change the time.

 6. Click Search to display the events that were logged on the specified date or 
within the specified period of time.

 7. If necessary, add or remove columns. Refer to Section 13.1.1.1: Adding or 
Removing Columns  for more information.

 8. If necessary, filter the logged event or events. Refer to Section 13.1.1.2: Filtering 
Messages  for more information.

 9. If necessary, print the logged event or events:
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 a. In the list with logged events select the event or events you want to print.

The selected logged event or events are highlighted.

NOTE:  You can select more than one logged event at a time. To select 
two or more logged events, press and hold the [Ctrl] key on your 
keyboard and then select the events. To select two or more successive 
logged events, you can also press and hold the [Shift] key on your 
keyboard and then select the first and the last event. To select all logged 
events displayed in the list, press and hold the [Ctrl] key and then press 
[A] on your keyboard.

 b. Click Print Logs.

An event log is created for the selected event(s) in Crystal Reports. In Crystal 
Reports you can print the event log.

 c. Click  to close Crystal Reports.

Fusion4 Portal is displayed again.

The logged events that match your search criteria are listed on the Logs tab.

13.1.2  Viewing Event and Calibration Logs
 l You can retrieve the latest event and calibration logs information of K factor and 

Meter factor changes periodically from Fusion4 Devices (MSCL and MSCA) in 
Fusion4Portal software.

 l By default, the logs are retrieved every 60 minutes and this time is configurable 
as per user need.

 l Once the log is read and displayed, it is marked processed and will not be 
displayed again on the Logs panel.
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 13.2  Enraf Process Control Center
The Enraf Process Control Center (EPCC) application is the control centre for all 
Enraf applications and services installed on the computer. This tool enables you to 
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start and stop the applications and services, and to monitor the status of these 
applications and services.

To start the EPCC, perform the following steps:

 1. From the Start menu select All Programs | Enraf | System | Enraf Process 
Control Center.

The EPCC icon is displayed in the notification area at the bottom right of the 
window.

NOTE:  If the EPCC icon is not displayed in the notification area: (1) Click  
(Show hidden icons) and select Customize... from the pop-up window; (2) In 
the drop-down list right next to the EPCC icon, select Show icon and 
notifications; (3) Click OK to save the changes and to close the window. The 
EPCC icon is displayed in the notification area.To view the EPCC user 
interface, right-click the EPCC icon in the notification area.

The EPCC displays a list of all Enraf applications and services installed on your 
computer.

NOTE:  By default the EPPC is started during Windows startup.

Fusion4 Portal Installation & Operation Manual

13  Portal Diagnostics | 236



CAUTION:  The EPCC should run continuously. If you close this application by 
clicking Exit in the EPCC user interface, the following warning is displayed:

13.2.1  Types of Applications and Services in EPCC
The EPCC displays a list of all Enraf software applications and services installed on 
your computer. These applications and services can be classified as follows:

Type of 
Application

Description

Windows 
Services 

These are the services/applications programmed to support some 
high level applications at a low level. Enraf Software Applications 
comprises of many such services. Examples: Enraf Gauge Data 
Server (EGDS) and Enraf BoL Printer.

Web 
Services 
hosted in 
Windows 
Services 

These are the Windows Communication Foundation (WCF) services 
also called as Web Services, which are hosted in Windows Services. 
These services interact across the network with applications which 
are installed on different machines. Examples: Enraf BoL Web Service 
and Enraf Initialisation Service.

Server 
applications

The server applications are generally started through specific clients. 
Therefore, the EPCC does not provide a ‘start’ option for these 
applications, only a ‘stop’ option. Example: Fusion4 Server.

Shortcuts
EPPC provides shortcuts for applications which are not required to 
always run on your computer. An examples is the Enraf License 
Manager.
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13.2.2  Starting and Stopping an Application or Service 
through EPCC

NOTE:  The EPCC enables you to start an application or service when it stopped 
running. When an application or service continues to stop running each time 
you started it, contact the engineer/supervisor or Guidant Support.

To start or stop an application or service through the EPCC, perform the following 
steps:

 1. Right-click the EPCC icon in the notification area.

The EPCC user interface is displayed.

 2. In the EPCC user interface, select Enraf Processes.

The Enraf applications and services installed on the computer are displayed 

 3. In the EPCC user interface, select the application or service you want to start or 
stop. Then click:

 l Start to start the application or service. This button is only active if the 
application or service is not running.

 l Stop to stop the application or service. This button is only active if the 
application or service is running.

NOTE:  If you want to stop all applications and services, select All Tasks and then 
Stop All.

 13.3  Device (1010CB) Error Status Codes
When there is a disturbance during the transfer of a batch, the system generates 
an alarm. The number of this alarm is displayed in the Batch Alarm column on the 
Bill of Lading (BoL). For a description of the error status codes, refer to:

 l 1010CB Protocol Manual

 l Fusion4 SSC-A Installation & Operation Manual
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 l Fusion4 SSC-B Installation & Operation Manual

 l Fusion4 MSC-A Installation & Operation Manual

 l Fusion4 MSC-L Installation & Operation Manual                 

In case of a Weights and Measures compliant system, the text ‘Unintended stop’ is 
displayed instead of a number. In  an example of a Bill of Lading for a 1010CB is 
shown.

 

 13.4  Troubleshooting
NOTE:  In case of an error or malfunction always check the Logs panel in 
Fusion4 Portal first (see Section 13.1: Logs).
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Problem Cause Solution
Installation

Fusion4 Portal will 
not work properly 
after installation is 
completed.

Installation of 
Fusion4 Portal was 
completed without 
correct password 
for “mngr” user 
account.

Correct log on for Enraf BoL Printer 
service. See Section 13.4.1: Correcting 
Log On for Enraf BoL Printer Service  and  
Section 13.4.2: Configuring the DCOM 
mngr Settings for Fusion4Server for more 
information.

Transactions 
performed are not 
retrieved by 
Fusion4 Portal.

Transactions 
performed are not 
retrieved if the 
devices have older 
version of firmware.

Ensure that the devices have mentioned 
versions or later versions of the firmware. 

 l MSC-L/MSC-A: R301 C1-1.05

 l SSC-A/SSC-B: A2419

 l 1010CB: P6-007-1010A-CB-
VEO05.002-2594

Check the real device for the appropriate 
firmware versions. For more information, 
refer the “Infor” section for SSC-A and 
SSC-B and the “Info” section for MSC-A 
and MSC-L.

Operation

Communication 
error

The terminal server 
goes to hung state 
after heavy and 
prolonged 
operation or due to 
third party 
applications 
causing CPU or 
memory overload.

Restart the computer running Fusion4 
Portal if the issue persists. Restarting the 
computer does not result in loss of 
transaction data or log data. However, it is 
recommended to restart the computer 
only during maintenance hours in order 
not to lose monitoring.
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Problem Cause Solution

Device 
transactions are 
not retrieved

The device serial 
number in the real 
device is not 
configured 
properly.

 l In Fusion4 Portal, check the log for an 
“*” for a specific device transaction. 

 l Check the real device for the 
appropriate serial number. For more 
information, refer the “Infor” section 
for SSC-A and SSC-B and the “Info” 
section for MSC-A and MSC-L. 

 l Contact the Fusion4 device 
Sales/Service Engineer to configure 
the appropriate serial number. The 
transactions with “*” must be manually 
settled and Fusion4 Portal must be 
restarted.

Printer
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Problem Cause Solution

The printer is not 
printing correctly 
or is not printing 
at all.

The printer is not 
connected to the 
computer.

Connect the printer to the computer.

There is a 
communication 
failure between the 
printer and the 
computer.

Check if the cables of the printer are 
connected properly to the computer.

The printer is 
switched off.

Switch the printer on.

There is no paper in 
the paper tray of 
the printer.

Insert paper in the paper tray.

The ink or toner 
cartridge is (almost) 
empty.

Replace the cartridge.

Printer is not 
configured as 
default printer for 
mngr account.

Configure printer as default printer for 
mngr account. Refer to Section 5.3.5: 
Configuring the Default Printer  for more 
information.

The localized 
characters are not 
displayed in the 
reports when the 
reports as saved 
as localized PDF 
files using the 
“Print to file” 
option.

The “Arial Unicode 
MS” font is not 
available in the 
system.

Download and install the “Arial Unicode 
MS” font from 
http://fontsov.com/download/12730.html.

Hard Disk
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Problem Cause Solution

The transaction 
data is not saved.

The hard disk used 
for storing the 
transaction data is 
full.

Make a backup of the transaction data on 
another hard disk. Subsequently, you can 
remove (part of) the transaction data from 
the hard disk normally used for storing 
the transaction data.

13.4.1  Correcting Log On for Enraf BoL Printer Service
During the installation of Fusion4 Portal, you are prompted to enter the password 
of the “mngr” user account if this user account already exists on the computer. If 
you entered the wrong password, a message is displayed. If you cannot remember 
the password for the “mngr” account, you must click Cancel in the mngr Account 
window for the installation to continue. The installation of Fusion4 Portal is 
completed. However, Fusion4 Portal does not work properly until the incorrect 
password issue is fixed.

To fix the password of the “mngr” user account, perform the following steps:

 1. Stop all services and exit the EPCC.

 a. Right-click the EPCC icon in the system tray.

 b. In the EPCC user interface, choose Enraf Processes | All Tasks | Stop All to 
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stop all services

 c. In the EPCC user interface, select Exit to exit the EPCC.

 2. From the Start menu, select Run.

The Run dialog box is displayed.

NOTE:  If Run... is not displayed in the Start menu: (1) Right-click on the Start 
menu icon and select Properties from the pop-up menu; (2) On the Start 
Menu tab in the Taskbar and Start Menu Properties window click 
Customize...; (3) In the Customize Start Menu window select the Run 
command check box and click OK to save the changes and to close the 
window; (4) Click OK to save the changes and to close the Taskbar and Start 
Menu Properties window.

 3. Enter services.msc in the Run dialog box. Then click OK.

The Services window is displayed.
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 4. Right-click the Enraf BoL Printer service, and select Properties from the pop-up 
menu.

The Enraf BoL Printer Properties window is displayed.
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 5. On the Log On tab enter the properties of the “mngr” user account:

 a. Select This account.

 b. Click Browse.

The Select User window is displayed
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 c. Enter mngr in the Enter the object name to select text box. Then click Check 
Names.

If the name of the user account you entered is located, the name including 
its location is displayed in the text box.

 6. Click OK to save the changes and to close the window.

The Enraf BoL Printer Properties window is displayed again.

Fusion4 Portal Installation & Operation Manual

13  Portal Diagnostics | 247



 7. Enter the (correct) password of the “mngr” user account in both the Password 
and Confirm password entry fields. Then click OK to save the changes and to 
close the window.

The Services window is displayed again. The name of the “mngr” user account is 
displayed in the Log on as column.
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 8. Close all windows and restart the computer.

 9. After restart of the computer check if the EPCC is started automatically, and if all 
Fusion4 Portal services are running.

If the EPCC is not started automatically, start it manually (Start | All Programs | 
Enraf | System | Enraf Process Control Center).

13.4.2  Configuring the DCOM mngr Settings for 
Fusion4Server

Perform the following steps to configure the DCOM mngr settings for 
Fusion4Server:

 1. Log on to the computer with the “mngr” account.

 2. Go to Start | Run....

The Run window is displayed.
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NOTE:  If Run... is not displayed in the Start menu: (1) Right-click on the Start 
icon and select Properties from the pop-up menu; (2) In the Taskbar and 
Start Menu Properties window go to the Start Menu tab; (3) Click 
Customize...; (4) Select the Run command check box; (5) Click OK to save the 
changes and to close the window, (6) Click OK to save the changes and to 
close the window.

 3. In the text field after Open: enter DCOMCnfg and click OK. The Component 
Services window is displayed.

Fusion4 Portal Installation & Operation Manual

13  Portal Diagnostics | 250



 4. Go to Console Root | Component Services | Computers | My Computer | 
DCOM Config.

 5. Right-click Fusion4 OPC DA Server.

The Fusion4 OPC DA Server Properties window is displayed.

 6. Click the Identity tab.

 7. Enter the password of the “mngr” user account in both the Password and 
Confirm password entry fields. Then click OK to save the changes and to close 
the window.

The Component Services window is displayed.

 8. Close the Component Services window.
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 13.5  Maintenance
To ensure proper operation, it is recommended that the computer running the 
Fusion4 Portal application is restarted periodically.

 l In a site where 1,000 or more transactions are performed daily, a restart of the 
computer is required once every two months.

 l In a site where less than 1,000 transactions are performed daily, a restart of the 
computer is required once every 3 months. 
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14  Fusion4 Portal Topology
 14.1  Introduction

The 1010CB devices and Fusion4 devices (SSC-As, SSC-Bs, MSC-As, and MSC-Ls) can 
be connected to the Fusion4 Portal computer in various ways:

 l Through an RS-232/RS-485 connection using an RS-232/RS-485 converter.

 l Through an RS-232/RS-485 to Ethernet connection using a terminal server and 
an Ethernet switch.

 l Through an Ethernet connection using an Ethernet switch. This type of 
connection is currently only supported by the MSC-A and MSC-L.

 l Through a combination of the above.

NOTES:

 1. The 1010CB supports RS-232 and RS-485. The SSC-A and the SSC-B support 
only RS-485. The MSC-A and MSC-L supports RS-232, RS-485 and Ethernet.

 2. Multiple devices can be connected to one port through a multidrop bus.

The following figure displays an example of a network topology in which the devices 
are connected to the Fusion4 Portal computer through an RS-232/RS-485 
connection using an RS-232/RS-485 converter.
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Figure 14-1: Fusion4 Portal serial network topology

The following figure displays an example of a network topology in which the devices 
are connected to the Fusion4 Portal computer through an RS-232/RS-485 to 
Ethernet connection using a terminal server and Ethernet switch.
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Figure 14-2: Fusion4 Portal Ethernet network topology with terminal server

NOTE:

 l This configuration is supported by having virtual COM ports on PC mapped 
to devices on serial lines.

 l We recommend you to use “Managed switches” (ports are not opened for 
external/other communication) for secured communication.
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 14.2  1010CBLoad Controller
For connecting a 1010CB load computer to a PC running Fusion4 Portal, refer to 
the 1010CB Card Descriptions and Wiring Manual.

 14.3  Multi-Stream Controller for Loading
A Multi-Stream Controller for Loading (MSC-L) can be connected to a PC running 
Fusion4 Portal in a number of ways, depending on the connectivity options of the 
PC. The following types of connection can be distinguished:

 l Serial connections, see section Section 14.4.1: Connecting MSC-A to Fusion4 
Portal through Serial Connection.

 l Ethernet connections, see section Section 14.4.2: Connecting MSC-A to Fusion4 
Portal through Ethernet Connection.

14.3.1  Connecting MSC-L to Fusion4 Portal through Serial 
Connection

There are a number of ways to connect an MSC-L to a PC running Fusion4 Portal 
through a serial connection. The possible connections are:

 l RS-485 half-duplex serial connection between the MSC-L and the PC running 
Fusion4 Portal, see section Section 14.3.1.1: RS-485 Half-Duplex Serial 
Connection.

 l RS-485 full-duplex serial connection between the MSC-L and the PC running 
Fusion4 Portal, see section Section 14.3.1.2: RS-485 Full-Duplex Serial 
Connection.

 l RS-485 to RS-232 half-duplex serial connection between the MSC-L and the PC 
running Fusion4 Portal using an RS-232 to RS-485 converter, see section 
Section 14.3.1.3: RS-485 to RS-232 Half-Duplex Serial Connection.

 l RS-485 to RS-232 full-duplex serial connection between the MSC-L and the PC 
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running Fusion4 Portal using an RS-232 to RS-485 converter, see section 
Section 14.3.1.4: RS-485 to RS-232 Full-Duplex Serial Connection.

When connecting an MSC-L to a PC running Fusion4 Portal keep the following in 
mind:

 l For an RS-485 half-duplex connection preferably use terminal connector block 
CN-150 or terminal connector block CN-151 on the CAN-HMI-MSC board of the 
MSC-L in order to guarantee optimum performance. If terminal connector block 
CN-151 is used, it must be configured for RS-485 half-duplex communication 
using the RS COMM mode switch SW2 on the CAN-HMI-MSC board.

 l For an RS-485 full-duplex connection preferably use terminal connector block 
CN-151 on the CAN-HMI-MSC board of the MSC-L in order to guarantee 
optimum performance. Furthermore, terminal connecter CN-151 must be 
configured for RS-485 full-duplex communication using the RS COMM mode 
switch SW2 on the CAN-HMI-MSC board.

 l For communications between the MSC-L and the PC FlexConn protocol is used.

 l When a multidrop bus connection is used maximum 5 devices or 25 streams, 
whichever limit is reached first, can be connected in order to guarantee 
optimum performance.

 l A site can have maximum 10 serial multidrop bus connections, i.e. maximum 50 
devices or 250 streams, whichever limit is reached first.

 l If the connection to the MSC-L represents the last link in a multidrop bus 
connection, then the bus must be terminated by setting jumpers JP7 and JP8 on 
the CAN-HMI-MSC board to the TERM (terminated) position. The serial bus will 
be terminated with a 120 Ohms resistor.

14.3.1.1  RS-485 Half-Duplex Serial Connection
The following figure schematically shows an RS-485 half-duplex serial connection 
between an MSC-L and a PC with Fusion4 Portal, in which terminal connector block 
CN-150 is used.
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Figure 14-3: RS-485 half-duplex serial connection between MSC-L and Fusion4 Portal (CN-150)

The following table describes the layout of terminal connector block CN-150 in a 
RS-485 half-duplex serial connection.

Table 14-1: Layout of Terminal Connector Block CN-150

Connector
Signal Name Signal Description

ID PIN

CN-150

COM-3 (+) RS485_A 2W RS-485 Tx+/Rx+
COM-3 (-) RS485_B 2W RS-485 Tx-/Rx-
COM-3 (C) RS485_0V 0 Volt
COM-4 (+) RS485_A 2W RS-485 Tx-/Rx+
COM-4 (-) RS485_B 2W RS-485 Tx-/Rx-
COM-4 (C) RS485_0V 0 Volt

The following figure schematically shows an RS-485 half-duplex serial connection 
between an MSC-L and a PC with Fusion4 Portal, in which terminal connector block 
CN-151 used.
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Figure 14-4: RS-485 half-duplex serial connection between MSC-L and Fusion4 Portal (CN-151)

The following table describes the terminal layout of connector CN-151 in a RS-485 
half-duplex serial connection.

Table 14-2: Layout of Terminal Connector CN-151

Connector
Signal Name Signal Description

ID Pin

CN-151

COM-5 (+) RS485_A 2W RS-485 Tx+/Rx+
COM-5 (-) RS485_B 2W RS-485 Tx-/Rx-
COM-5 (C) RS485_0V 0 Volt

N/A N/A N/A
N/A N/A N/A

NOTE:  Terminal connector block CN-151 must be configured for RS-485 half-
duplex communication using the RS COMM mode switch SW2 on the CAN-HMI-
MSC board.

14.3.1.2  RS-485 Full-Duplex Serial Connection
The following figure schematically shows an RS-485 full-duplex serial connection 
between an MSC-L and a PC with Fusion4 Portal.
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Figure 14-5: RS-485 full-duplex serial connection between MSC-L and Fusion4 Portal

The following table describes the terminal layout of connector CN-151 in an RS-485 
full-duplex connection.

Table 14-3: Layout of Terminal Connector CN-151

Connector
Signal Name Signal Description

ID Pin

CN-151

COM-5 (Rx+) RS485_A 4W RS-485 Rx+
COM-5 (Rx-) RS485_B 4W RS-485 Rx-
COM-5 (Tx+) RS485_Y 4W RS-485 Tx+
COM-5 (Tx-) RS485_Z 4W RS-485 Tx-
COM-5 (C) RS485_0V 0 Volt

NOTE:  Terminal connector block CN-151 must be configured for RS-485 full-
duplex communication using the RS COMM mode switch SW2 on the CAN-HMI-
MSC board.

14.3.1.3  RS-485 to RS-232 Half-Duplex Serial Connection
The following figure schematically shows an RS-485 to RS-232 half-duplex serial 
connection between an MSC-L and a PC with Fusion4 Portal, in which an RS-232 to 
RS-485 converter is used.
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Figure 14-6: RS-485 to RS-232 half-duplex serial connection between MSC-L and Fusion4 Portal

The following table describes the layout of terminal connector block CN-150 in an 
RS-485 to RS-232 half-duplex serial connection.

Table 14-4: Layout of Terminal Connector Block CN-150

Connector
Signal Name Signal Description

ID Pin

CN-150

COM-3 (+) RS485_A 2W RS-485 Tx+/Rx+
COM-3 (-) RS485_B 2W RS-485 Tx-/Rx-
COM-3 (C) RS485_0V 0 Volt
COM-4 (+) RS485_A 2W RS-485 Tx+/Rx+
COM-4 (-) RS485_B 2W RS-485 Tx-/Rx-
COM-4 (C) RS485_0V 0 Volt

14.3.1.4  RS-485 to RS-232 Full-Duplex Serial Connection
The following figure schematically shows an RS-485 to RS-232 full-duplex serial 
connection between an MSC-L and a PC with Fusion4 Portal, in which an RS-232 to 
RS-485 converter is used.
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Figure 14-7: RS-485 to RS-232 full-duplex serial connection between MSC-L and Fusion4 Portal

The following table describes the terminal layout of connector CN-151 in an RS-485 
to RS-232 full-duplex serial connection.

Table 14-5: Layout of Terminal Connector CN-151

Connector
Signal Name Signal Description

ID Pin

CN-151

COM-5 (Rx+) RS485_A 4W RS-485 Rx+
COM-5 (Rx-) RS485_B 4W RS-485 Rx-
COM-5 (Tx+) RS485_Y 4W RS-485 Tx+
COM-5 (Tx-) RS485_Z 4W RS-485 Tx-
COM-5 (C) RS485_0V 0 Volt

NOTE:  Terminal connector block CN-151 must be configured for RS-485 full-
duplex communication using the RS COMM mode switch SW2 on the CAN-HMI-
MSC board.

14.3.2  Connecting MSC-L to Fusion4 Portal through Ethernet 
Connection

An MSC-L can be connected to a PC running Fusion4 Portal through an Ethernet 
connection. In doing so, keep the following in mind:
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 l Preferably use terminal connector block CN-152 on the CAN-HMI-MSC board of 
the MSC-L in order to guarantee optimum performance.

 l For communications between the MSC-L and the PC running Fusion4 Portal the  
FlexConn protocol is used.

 l It is not recommended to connect an MSC-L directly to the PC running Fusion4 
Portal. Preferably use a switch between the MSC-L and the PC. Furthermore, the 
use of a switch enables you to connect multiple MSC-L’s.

 l Maximum 50 devices can be connected in order to guarantee optimum 
performance. The maximum number of transactions is 2000 per day.

14.3.2.1  Ethernet Connection with Ethernet Switch
The following figure schematically shows an Ethernet connection between an MSC-
L and a PC running Fusion4 Portal, in which an Ethernet switch is used.

Figure 14-8: Ethernet connection between MSC-L and Fusion4 Portal with Ethernet switch

The following table describes the terminal layout of connector CN-152.
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Table 14-6: Layout of Terminal Connector CN-152

Connector
Signal Name Signal Description

ID Pin

CN-152

ETH-2 (R+) R+ Receive +
ETH-2 (R-) R- Receive -
ETH-2 (T+) T+ Transmit +
ETH-2 (T-) T- Transmit -

 14.4  Multi-Stream Controller for Additive 
Injection

A Multi-Stream Controller for Additive Injection (MSC-A) can be connected to a PC 
running Fusion4 Portal in a number of ways, depending on the connectivity options 
of the PC. The following types of connection can be distinguished:

 l Serial connections, see section Section 14.4.1: Connecting MSC-A to Fusion4 
Portal through Serial Connection.

 l Ethernet connections, see section Section 14.4.2: Connecting MSC-A to Fusion4 
Portal through Ethernet Connection.

14.4.1  Connecting MSC-A to Fusion4 Portal through Serial 
Connection

There are a number of ways to connect an MSC-A to a PC running Fusion4 Portal 
through a serial connection. The possible connections are:

 l RS-485 half-duplex serial connection between the MSC-A and the PC running 
Fusion4 Portal, see section Section 14.4.1.1: RS-485 Half-Duplex Serial 
Connection.

 l RS-485 full-duplex serial connection between the MSC-A and the PC running 
Fusion4 Portal, see section Section 14.4.1.2: RS-485 Full-Duplex Serial 
Connection.
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 l RS-485 to RS-232 half-duplex serial connection between the MSC-A and the PC 
running Fusion4 Portal using an RS-232 to RS-485 converter, see section 
Section 14.4.1.3: RS-485 to RS-232 Half-Duplex Serial Connection.

 l RS-485 to RS-232 full-duplex serial connection between the MSC-A and the PC 
running Fusion4 Portal using an RS-232 to RS-485 converter, see section 
Section 14.4.1.4: RS-485 to RS-232 Full-Duplex Serial Connection.

When connecting an MSC-A to a PC running Fusion4 Portal keep the following in 
mind:

 l For an RS-485 half-duplex connection preferably use terminal connector block 
CN-150 or terminal connector block CN-151 on the CAN-HMI-MSC board of the 
MSC-A in order to guarantee optimum performance. If terminal connector block 
CN-151 is used, it must be configured for RS-485 half-duplex communication 
using the RS COMM mode switch SW2 on the CAN-HMI-MSC board.

 l For an RS-485 full-duplex connection preferably use terminal connector block 
CN-151 on the CAN-HMI-MSC board of the MSC-A in order to guarantee 
optimum performance. Furthermore, terminal connecter CN-151 must be 
configured for RS-485 full-duplex communication using the RS COMM mode 
switch SW2 on the CAN-HMI-MSC board.

 l For communications between the MSC-A and the PC FlexConn protocol is used.

 l When a multidrop bus connection is used maximum 5 devices or 25 streams, 
whichever limit is reached first, can be connected in order to guarantee 
optimum performance.

 l A site can have maximum 10 serial multidrop bus connections, i.e. maximum 50 
devices or 250 streams, whichever limit is reached first.

 l If the connection to the MSC-A represents the last link in a multidrop bus 
connection, then the bus must be terminated by setting jumpers JP7 and JP8 on 
the CAN-HMI-MSC board to the TERM (terminated) position. The serial bus will 
be terminated with a 120 Ohms resistor.

14.4.1.1  RS-485 Half-Duplex Serial Connection
The following figure schematically shows an RS-485 half-duplex serial connection 
between an MSC-A and a PC with Fusion4 Portal, in which terminal connector block 
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CN-150 is used.

Figure 14-9: RS-485 half-duplex serial connection between MSC-A and Fusion4 Portal (CN-150)

The following table describes the layout of terminal connector block CN-150 in a 
RS-485 half-duplex serial connection.

Table 14-7: Layout of Terminal Connector Block CN-150

Connector
Signal Name Signal Description

ID Pin

CN-150

COM-3 (+) RS485_A 2W RS-485 Tx+/Rx+
COM-3 (-) RS485_B 2W RS-485 Tx-/Rx-
COM-3 (C) RS485_0V 0 Volt
COM-4 (+) RS485_A 2W RS-485 Tx+/Rx+
COM-4 (-) RS485_B 2W RS-485 Tx-/Rx-
COM-4 (C) RS485_0V 0 Volt

The following figure schematically shows an RS-485 half-duplex serial connection 
between an MSC-A and a PC with Fusion4 Portal, in which terminal connector block 
CN-151 used.
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Figure 14-10: RS-485 half-duplex serial connection between MSC-A and Fusion4 Portal (CN-151)

The following table describes the terminal layout of connector CN-151 in a RS-485 
half-duplex serial connection.

Table 14-8: Layout of Terminal Connector CN-151

Connector
Signal Name Signal Description

ID Pin

CN-151

COM-5 (+) RS485_A 2W RS-485 Tx+/Rx+
COM-5 (-) RS485_B 2W RS-485 Tx-/Rx-
COM-5 (C) RS485_0V 0 Volt

N/A N/A N/A
N/A N/A N/A

NOTE:  Terminal connector block CN-151 must be configured for RS-485 half-
duplex communication using the RS COMM mode switch SW2 on the CAN-HMI-
MSC board.

14.4.1.2  RS-485 Full-Duplex Serial Connection
The following figure schematically shows an RS-485 full-duplex serial connection 
between an MSC-A and a PC with Fusion4 Portal.
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Figure 14-11: RS-485 full-duplex serial connection between MSC-A and Fusion4 Portal

The following table describes the terminal layout of connector CN-151 in an RS-485 
full-duplex connection.

Table 14-9: Layout of Terminal Connector CN-151

Connector
Signal Name Signal Description

ID Pin

CN-151

COM-5 (Rx+) RS485_A 4W RS-485 Rx+
COM-5 (Rx-) RS485_B 4W RS-485 Rx-
COM-5 (Tx+) RS485_Y 4W RS-485 Tx+
COM-5 (Tx-) RS485_Z 4W RS-485 Tx-
COM-5 (C) RS485_0V 0 Volt

NOTE:  Terminal connector block CN-151 must be configured for RS-485 full-
duplex communication using the RS COMM mode switch SW2 on the CAN-HMI-
MSC board.

14.4.1.3  RS-485 to RS-232 Half-Duplex Serial Connection
The following figure schematically shows an RS-485 to RS-232 half-duplex serial 
connection between an MSC-A and a PC with Fusion4 Portal, in which an RS-232 to 
RS-485 converter is used.
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Figure 14-12: RS-485 to RS-232 half-duplex serial connection between MSC-A and Fusion4 Portal

The following table describes the layout of terminal connector block CN-150 in an 
RS-485 to RS-232 half-duplex serial connection.

Table 14-10: Layout of Terminal Connector Block CN-150

Connector
Signal Name Signal Description

ID Pin

CN-150

COM-3 (+) RS485_A 2W RS-485 Tx+/Rx+
COM-3 (-) RS485_B 2W RS-485 Tx-/Rx-
COM-3 (C) RS485_0V 0 Volt
COM-4 (+) RS485_A 2W RS-485 Tx+/Rx+
COM-4 (-) RS485_B 2W RS-485 Tx-/Rx-
COM-4 (C) RS485_0V 0 Volt

14.4.1.4  RS-485 to RS-232 Full-Duplex Serial Connection
The following figure schematically shows an RS-485 to RS-232 full-duplex serial 
connection between an MSC-A and a PC with Fusion4 Portal, in which an RS-232 to 
RS-485 converter is used.
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Figure 14-13: RS-485 to RS-232 full-duplex serial connection between MSC-A and Fusion4 Portal

The following table describes the terminal layout of connector CN-151 in an RS-485 
to RS-232 full-duplex serial connection.

Table 14-11: Layout of Terminal Connector CN-151

Connector
Signal Name Signal Description

ID Pin

CN-151

COM-5 (Rx+) RS485_A 4W RS-485 Rx+
COM-5 (Rx-) RS485_B 4W RS-485 Rx-
COM-5 (Tx+) RS485_Y 4W RS-485 Tx+
COM-5 (Tx-) RS485_Z 4W RS-485 Tx-
COM-5 (C) RS485_0V 0 Volt

NOTE:  Terminal connector block CN-151 must be configured for RS-485 full-
duplex communication using the RS COMM mode switch SW2 on the CAN-HMI-
MSC board.

14.4.2  Connecting MSC-A to Fusion4 Portal through Ethernet 
Connection

An MSC-A can be connected to a PC running Fusion4 Portal through an Ethernet 
connection. In doing so, keep the following in mind:
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 l Preferably use terminal connector block CN-152 on the CAN-HMI-MSC board of 
the MSC-A in order to guarantee optimum performance.

 l For communications between the MSC-A and the PC running Fusion4 Portal the 
FlexConn protocol is used.

 l It is not recommended to connect an MSC-A directly to the PC running Fusion4 
Portal. Preferably use a switch between the MSC-A and the PC. Furthermore, the 
use of a switch enables you to connect multiple MSC-A’s.

 l Maximum 50 devices can be connected in order to guarantee optimum 
performance. The maximum number of transactions is 2000 per day.

14.4.2.1  Ethernet Connection with Ethernet Switch
The following figure schematically shows an Ethernet connection between an MSC-
A and a PC running Fusion4 Portal, in which an Ethernet switch is used.

Figure 14-14: Ethernet connection between MSC-A and Fusion4 Portal with Ethernet switch

The following table describes the terminal layout of connector CN-152.
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Table 14-12: Layout of Terminal Connector CN-152

Connector
Signal Name Signal Description

ID Pin

CN-152

ETH-2 (R+) R+ Receive +
ETH-2 (R-) R- Receive -
ETH-2 (T+) T+ Transmit +
ETH-2 (T-) T- Transmit -

 14.5  Single Stream Controller for Blending
The Single Stream Controller for Blending (SSC-B) can be connected to a PC 
running Fusion4 Portal in a number of ways, depending on the connectivity options 
of the PC. The possible connections are:

 l RS-485 half-duplex serial connection between the SSC-B and the PC running 
Fusion4 Portal, see section Section 14.5.1: RS-485 half-duplex serial connection.

 l RS-485 to RS-232 half-duplex serial connection between the SSC-B and the PC 
running Fusion4 Portal using an RS-232 to RS-485 converter, see section 
Section 14.5.2: RS-485 to RS-232 Half-Duplex Serial Connection.

 l RS-485 half-duplex serial connection between the SSC-B and the PC running 
Fusion4 Portal using a terminal server, see section Section 14.5.3: RS-485 Half-
Duplex Serial Connection with Terminal Server.

When connecting an SSC-B to a PC running Fusion4 Portal keep the following in 
mind:

 l Preferably use terminal connector block CN7 on the CAN-OPTION-SSC board of 
the SSC-B in order to guarantee optimum performance.

 l For communications between the SSC-B and the PC FlexConn protocol is used.

 l When a multidrop bus connection is used maximum 5 devices or 25 streams, 
whichever limit is reached first, can be connected in order to guarantee 
optimum performance.
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 l A site can have maximum 10 multidrop bus connections, i.e. maximum 50 
devices or 250 streams, whichever limit is reached first.

 l If the connection to the SSC-B represents the last link in a multidrop bus 
connection, then the bus must be terminated by setting jumper JP8 on the CAN-
OPTION-SSC board of the SSC-B to the TERM (terminated) position. The serial 
bus will be terminated with a 120 Ohms resistor.

14.5.1  RS-485 half-duplex serial connection
The following figure schematically shows an RS-485 half-duplex serial connection 
between an SSC-B and a PC with Fusion4 Portal.

Figure 14-15: RS-485 half-duplex serial connection between SSC-B and Fusion4 Portal

The following table describes the layout of terminal connector block CN7 in an 
RS-485 half-duplex serial connection.

Table 14-13: Layout of Terminal Connector Block CN7

Connector
Signal Name Signal Description

ID Pin

CN7
74 RS485_A 2W RS-485 Tx+/Rx+
75 RS485_B 2W RS-485 Tx-/Rx-
76 RS485_0V 0 Volt
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14.5.2  RS-485 to RS-232 Half-Duplex Serial Connection
The following figure schematically shows an RS-485 to RS-232 half-duplex serial 
connection between an SSC-B and a PC with Fusion4 Portal, in which an RS-232 to 
RS-485 converter is used.

Figure 14-16: RS-485 to RS-232 half-duplex serial connection between SSC-B and Fusion4 Portal

The following table describes the layout of terminal connector block CN7 in an 
RS-485 to RS-232 half-duplex serial connection.

Table 14-14: Layout of Terminal Connector Block CN7

Connector
Signal Name Signal Description

ID Pin

CN7
74 RS485_A 2W RS-485 Tx+/Rx+
75 RS485_B 2W RS-485 Tx-/Rx-
76 RS485_0V 0 Volt

14.5.3  RS-485 Half-Duplex Serial Connection with Terminal 
Server

A terminal server is used to create a multidrop bus connection between multiple 
devices and a PC running Fusion4 Portal. The following figure schematically shows 
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an RS-485 connection between an SSC-B and a PC running Fusion4 Portal, in which 
a terminal server is used.

Figure 14-17: RS-485 connection between SSC-B and Fusion4 Portal with terminal server

The following table describes the layout of terminal connector block CN7 in an 
RS-485 half-duplex serial connection, in which a terminal server is used.

Table 14-15: Layout of Terminal Connector Block CN7

Connector
Signal Name Signal Description

ID Pin

CN7
74 RS485_A 2W RS-485 Tx+/Rx+
75 RS485_B 2W RS-485 Tx-/Rx-
76 RS485_0V 0 Volt

 14.6  Single Stream Controller for Additive 
Injection

The Single Stream Controller for Additive Injection (SSC-A) can be connected to a PC 
running Fusion4 Portal in a number of ways, depending on the connectivity options 
of the PC. The possible connections are:
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 l RS-485 half-duplex serial connection between the SSC-A and the PC running 
Fusion4 Portal, see section Section 14.6.1: RS-485 half-duplex serial connection.

 l RS-485 to RS-232 half-duplex serial connection between the SSC-A and the PC 
running Fusion4 Portal using an RS-232 to RS-485 converter, see section 
Section 14.6.2: RS-485 to RS-232 Half-Duplex Serial Connection.

 l RS-485 half-duplex serial connection between the SSC-A and the PC running 
Fusion4 Portal using a terminal server, see section Section 14.6.3: RS-485 Half-
Duplex Serial Connection with Terminal Server.

When connecting an SSC-A to a PC running Fusion4 Portal keep the following in 
mind:

 l Preferably use terminal connector block CN7 on the CAN-OPTION-SSC board of 
the SSC-A in order to guarantee optimum performance.

 l For communications between the SSC-A and the PC FlexConn protocol is used.

 l When a multidrop bus connection is used maximum 5 devices or 25 streams, 
whichever limit is reached first, can be connected in order to guarantee 
optimum performance.

 l A site can have maximum 10 multidrop bus connections, i.e. maximum 50 
devices or 250 streams, whichever limit is reached first.

 l If the connection to the SSC-A represents the last link in a multidrop bus 
connection, then the bus must be terminated by setting jumper JP8 on the CAN-
OPTION-SSC board of the SSC-A to the TERM (terminated) position. The serial 
bus will be terminated with a 120 Ohms resistor.

14.6.1  RS-485 half-duplex serial connection
The following figure schematically shows an RS-485 half-duplex serial connection 
between an SSC-A and a PC with Fusion4 Portal.
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Figure 14-18: RS-485 half-duplex serial connection between SSC-A and Fusion4 Portal

The following table describes the layout of terminal connector block CN7 in an 
RS-485 half-duplex serial connection.

Table 14-16: Layout of Terminal Connector Block CN7

Connector
Signal Name Signal Description

ID Pin

CN7
74 RS485_A 2W RS-485 Tx+/Rx+
75 RS485_B 2W RS-485 Tx-/Rx-
76 RS485_0V 0 Volt

14.6.2  RS-485 to RS-232 Half-Duplex Serial Connection
The following figure schematically shows an RS-485 to RS-232 half-duplex serial 
connection between an SSC-A and a PC with Fusion4 Portal, in which an RS-232 to 
RS-485 converter is used.
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Figure 14-19: RS-485 to RS-232 half-duplex serial connection between SSC-A and Fusion4 Portal

The following table describes the layout of terminal connector block CN7 in an 
RS-485 to RS-232 half-duplex serial connection.

Table 14-17: Layout of Terminal Connector Block CN7

Connector
Signal Name Signal Description

ID Pin

CN7
74 RS485_A 2W RS-485 Tx+/Rx+
75 RS485_B 2W RS-485 Tx-/Rx-
76 RS485_0V 0 Volt

14.6.3  RS-485 Half-Duplex Serial Connection with Terminal 
Server

A terminal server is used to create a multidrop bus connection between multiple 
devices and a PC running Fusion4 Portal. The following figure schematically shows 
an RS-485 connection between an SSC-A and a PC running Fusion4 Portal, in which 
a terminal server is used.
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Figure 14-20: RS-485 connection between SSC-A and Fusion4 Portal with terminal server

The following table describes the layout of terminal connector block CN7 in an 
RS-485 half-duplex serial connection, in which a terminal server is used.

Table 14-18: Layout of Terminal Connector Block CN7

Connector
Signal Name Signal Description

ID Pin

CN7
74 RS485_A 2W RS-485 Tx+/Rx+
75 RS485_B 2W RS-485 Tx-/Rx-
76 RS485_0V 0 Volt
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